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Presentation

The purpose of this document is to take people on a fast path to successfully achieve PeSIT file transfer between two instances of IBM
Sterling Connect:Express (C:X) isolated to each other by an instance of IBM Sterling Secure Proxy (SSP). This tutorial will cover how to
generate SSL certificates, how to install these certificates and how to configure SSL on the C:X instances and SSP.

Architecture

Here is a picture of the architecture used in this tutorial.
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CX1 SSP CX2
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SSPcm

This is a very simple architecture with 2 instances of Connect:Express (CX1 and CX2) and 1 instance of Sterling Secure Proxy (SSP)
and its configuration manager (named hereafter SSPcm or CM). A production environment will probably use a remote perimeter server,
an external authentication server, firewalls, load balancer, and so on. Also, for the secured communication between SSP and CM we
will keep using the factory certificates which is not recommended for a production platform.

Requirements

Before going through this tutorial some pieces of hardware and software are required.

Hardware

The following hosts are required.
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* A UNIX host named cx1. The UNIX flavor used in this tutorial is Ubuntu 10.04.
* A Microsoft Windows host named ¢x2. The Windows version used in this this tutorial is Microsoft Windows XP SP3.

* A UNIX or Microsoft Windows host named ssp. For this tutorial we used Microsoft Windows XP SP3.

Software
The following products are required.
¢ IBM Connect:Express V1.5.00 for UNIX. C:X must be installed on host cx1.
¢ IBM Connect:Express V3.1.00 for Windows. C:X must be installed on host cx2.
* IBM Sterling Secure Proxy V3.4.0 for UNIX or Windows; SSP must be installed on host ssp.

¢ An implementation of OpenSSL (V0.9.8 or later) for UNIX or Microsoft Windows. Most of the UNIX flavors come with an OpenSSL
package. A few number of implementations can be found on Internet for the Microsoft Windows platform. OpenSSL for Windows is
one of them (see the References section).

¢ The network must be properly configured on each host; ssp must know cx1 and cx2; cx1 and cx2 must know ssp. The traffic must
be allowed between ssp and cx1, ssp and cx2, cx1 and ssp, cx2 and ssp. Use the ping command to ensure this is the case.

This tutorial will not cover the installation of the above products. Refer to their relevant documentation to know how to install these
products (see the References section).

SSL certificates

When a client connects to a SSL server, the server sends back to the client its certificate. The client then checks that the received
certificate is trusted with a certificate issued by a Certification Authority (CA). If the certificate is trusted, then the connection can be
established and the data can be encrypted using the server public key. Using SSL with SSP and the PeSIT protocol in our architecture
requires 3 certificates: 1 for SSP and 1 per instance of Connect:Express

Use of self-signed certificates

For the purpose of this tutorial we will use self-signed certificates. Self-signed certificates are perfectly suitable for test or development
environment but not for a production environment where it is strongly recommended to use certificates issued by a trusted Certificate
Authority. The advantage of a self-signed certificate is that it is trusted by itself which means that the certificated can also be used as a
CA certificate. To succeed the SSL handshake with a server, the self-signed certificate has to be found in the client certificate store.

Creation of the self-signed certificates for SSP and C:X instances
On a host where OpenSSL is installed run the following commands:

openssl req -x509 -days 365 -subj "/C=FR/L=Paris/O=IBM/OU=France Labs/CN=SSP Certificate" -newkey
rsa:1024 -keyout sspKey.pem -out sspCert.pem -passout pass:password

openssl pkcsl2 -export -in sspCert.pem -inkey sspKey.pem -passin pass:password -certfile
sspCert.pem -name "SSP Certificate" -out sspCert.pl2 -passout pass:password

openssl req -x509 -days 365 -subj "/C=FR/L=Paris/O=IBM/OU=France Labs/CN=CX1l Certificate" -newkey
rsa:1024 -keyout cxlKey.pem -out cxlCert.pem -passout pass:password

openssl pkcsl2 -export -in cxlCert.pem -inkey cxlKey.pem -passin pass:password -certfile
cxlCert.pem -name "CX1 Certificate" -out cxlCert.pl2 -passout pass:password

openssl req -x509 -days 365 -subj "/C=FR/L=Paris/O=IBM/OU=France Labs/CN=CX2 Certificate" -newkey
rsa:1024 -keyout cx2Key.pem -out cx2Cert.pem -passout pass:password

openssl pkcsl2 -export -in cx2Cert.pem -inkey cx2Key.pem -passin pass:password -certfile
cx2Cert.pem -name "CX2 Certificate" -out cx2Cert.pl2 -passout pass:password

The above commands have created 3 self-signed certificates: SSP Certificate, CX1 Certificate and CX2 Certificate which will be valid
during 365 days. For each certificate there are 3 files:

* (cxl|cx2|ssp)Cert.pem the certificate which contain the public key;
* (cxl|cx2|ssp)Key.pem the encrypted private keys; the password used for the encryption is password;

* (cxl|cx2|ssp)Cert.pl2 the certificate and the private key encrypted in a PKCS12 format file.
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Notes:
* PEM files are text files which can be displayed using a simple text editor;

¢ with the openssl req command above, a private key is normally encrypted in Traditional PEM-Encoded format (is starts with
————— BEGIN RSA PRIVATE KEY-----);if for some reason, the private key is encrypted in PKCS#8 format (it starts with
————— BEGIN ENCRYPTED PRIVATE KEY-----)then use the openssl pkcs8 command to change the encryption format.

Import the self-signed certificates in SSP

SSP is using its own certificate stores. The self-signed certificates created above can be imported in the SSP configuration using SSP
configuration manager (SSPcm) graphical interface. Before importing the certificates make sure the SSPcm graphical interface is
running. If not, run the following Microsoft Windows command:

C:\Program Files\Sterling Commerce\SSPcm\bin\startCM.bat

Note:

¢ Sterling Secure Proxy is available for different platforms (Microsoft Windows and different UNIX flavors). In this tutorial
we are using SSP for Microsoft Windows and the command have a .bat extension. For UNIX, the commands have the
same base name but with a . sh extension.

When SSPcm is ready you should see something like:

IEM Sterling Secure Proxy Configuration Manager Uersion 3.4.868, Build 126
<G> Copyright IBM Corp. 2883, 20911 All Rights Reserved.

IBEM and the IBM logo are Trademarks of International Business Machines.
IBM Sterling Secure Proxy Configuration Manager Starting..

IBM Sterling Secure Proxy Configuration Manager is ready for Service.

To connect the UI to the Configuration Manager Server. open a web browser to
https://z=p:8443/858PDashbhoard

Point your favorite web browser to the displayed URL (https://ssp:8443/SSPDashboard/ in the above snapshot) . Something similar to
the following must be shown.

IBM: Sterling Secure Proxy

Sign in to IBM Sterling Secure Proxy

User ID: | |

Password | |

[ signin | [ NewPassword |

@ Copyright IBM Corp. 2003, 2011 All Rights Reserved
IBM and the IBM logo are Trademarks of International Business Machines.

Tita

Java and all Java-based trademarks and logos are rademarks or registered trademarks of Oracle and/or its affiliates.

5/66


https://ssp:8443/SSPDaskboard/

PeSIT file transfer with IBM Sterling Secure Proxy E _ ===

IBM: Sterling Secure Proxy

C Monitoring Credentials Advanced System Help Sign Out
Configuration Actions =

B Engines

Adapters

@ Netmaps

Rz Policies

il -

© Copyright IBM Corp. 2003, 2011 All Rights Reserved.

From the left, expand Certificate Stores, then System Certificate Stores and select the default trusted certificate store dfltKeyStore.

IBM. Sterling Secure Proxy

Configuration Monitoring Credentials Advanced System Help Sign Out
System Certificate Store Configuration

Credentats fetor= = * System Certificate Store Name |dﬁlKE Store
- Certificate Stores De:cnpﬂon: s Y

13 Trusted Certificate Stores efault key store

E System Certificate Stores

dfitKeyStore
b e SSH Key Stores Software Keys | HSM Keys |
b ¢# User Stores Filter by Name ( ]
Name Valid To Date Description
) | sspDefaulteyCert | 2032-11-04 02:58:42 AM ssp default key certificate
S New | [ Edit | [ Copy | [ Delete |
T " [ save | [cancel | [ Hep |

A list of already imported certificates must be displayed.
Notes:

* We could keep using the existing sspDefaultKeyCert certificate between SSP and the C:X partners but, for the

purpose of this tutorial, and for security reason (you should not use for the SSP default certificate in production), we show
how to use a new certificate.

¢ For clarity we keep using the default stores from installation, but it is possible to create other stores.
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Click the New button and fill the fields System Certificate Name, Description (optional), Password of the encrypted private key and
Import From File. Use the Browse... button to find the ssp_cert.p12 file which has been created earlier in this paragraph (you will

maybe have to copy this file to the host where you browser is running). Once the content of the file has been successfully parsed you
should see something similar to the picture below.

<||I|
Jin
@

IBM. Sterling Secure Proxy

Configuration Maonitoring Credentials Advanced System Help Sign Out
System Certificate Configuration
‘ Credentials Actions ¥
A Certficate Stores & Enable Certificate
Trusted Certificate Sto
b " erificate slores * System Certificate Name: [sspcert ]
+ [z System Certificate Stores .
&) Description SSP self-signed certificate
dfitieyStore
b = SSH Key Stores .
[ £ User Stores Password: sessssss
Import From File | Browse... |
Certificate Data: |Certificate Summary
|Certificate ID: sspCert
Description Certificate: lof2
Version: 2
Issuer:
+Common Name:SSP Certificate :
Oranni LinitC Lok
S
Ok | [ cancel | [ Help |
| E
Refresh Tree

Ensure the Enable Certificate check box is ticked and click the Ok button. The imported certificate should now appear in the System
Certificate Store Configuration list.

IBM: Sterling Secure Proxy

Configuration Monitoring Credentials Advanced System Help Sign Out
System Certificate Store Configuration
Credentials Actions 7 " )
- Certificate Stores D::;:;:O?amﬁcale Store Name: |dﬁlKeyS{ure
I [z3 Trusted Certificate Stores ’ Default key store
- System Certificate Stores
dfitKeyStore
I = SSH Key Stores Sofware Keys ‘ L LEE ‘
13 @ User Stores Filter by Name [ ]
Name * | Valid To Date * | Description +
) | sspDefaultkeyCert | 2032-11-04 02:50:42 AM ssp default key certificate
) | sspCert 2012-09-04 11:46:43 AM S5P Certificate
— New | [ Edit | [ Copy | [ Delete |
o " ‘ Save ‘lcannelll Help |

Click the Save button to save the configuration. The SSP certificate is now installed in the default system certificates store. It's now the
turn of the C:X instances certificates to be installed, but in the default Trusted Certificates store this time.

Expand the Trusted Certificate Stores and select the default trusted certificate store dfitTrustStore.
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IBM: Sterling Secure Proxy

Configuration Monitoring

Credentials

Advanced

System

—
——

i
[{[T]

1l
-||I|
Tl
@

Help

Sign Out

Credentials Actions ¥
¥ Certificate Stores
- Trusted Certificate Stores
dfitTrustStore
L4 System Certificate Stores
ditkeyStore
P = SSH Key Stores
b f8 User Stores

Refresh Tree

* Trusted Cerificate Store Name
Description:

Software Keys

Trusted Certificate Store Configuration

| dfitTrustStore

Default trust store

Filter by Name [ ]
Name Valid To Date Description
_) | sspDefaultTrustedCert | 2032-11-04 03:02:28 AM ssp default trusted certificate
New | [ Edit | [ Copy | [ Delete |
| save | [ cancel | [ Help |

Click the New button and fill the fields Trusted Certificate Name, Description (optional). Use the Browse... button to find the
cxlCert.pem file which has been created earlier in this paragraph (you will maybe have to copy this file to the host where you browser
is running). Once the content of the file has been successfully parsed you should see something similar to the picture below.

IBM: Sterling Secure Proxy

Configuration Manitaring

Credentials

Advanced

System

Help Sign Qut

Credentials Actions 7
- Certificate Stores
- Trusted Certificate Stores
dfitTrustStore
= [ System Certificate Stores
dfitkeyStore
b f= SSH Key Stores
P & User Stores

Refresh Tree

& Enable Certificate
* Trusted Certificate Name
Description

Impart from file:

Certificate Data:

Trusted Certificate Configuration

[cx1cen

CX1 self-sighed certificate

[Certificate Summary
[Certificate ID: cx1Cert
Description Certificate: lofl
Version: 2
Issuer:
«Common Name:CX1 Certificate
«Organization UnitFrance Labs 4
e )
-
Ok | [ cancel | [ Help

Click Ok the button. Click the New button again and fill the fields Trusted Certificate Name, Description (optional). Use the Browse...
button to find the cx2Cert . pem file which has been created earlier in this paragraph (you will maybe have to copy this file to the host
where you browser is running). Once the content of the file has been successfully parsed you should see something similar to the

picture below.
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IBM: Sterling Secure Proxy

Configuration Monitoring

Credentials Advanced

System

Credentials
< [z3 Certificate Stores
e Trusted Certificate Stores
dfitTrustStore
- System Certificate Stores
dfitKeyStore
P jf= SSH Key Stores
b (& User Stores

Refresh Tree

Click Ok the button.

Actions ¥

& Enable Certificate
* Trusted Certificate Name:
Description:

Import from file

Certificate Data:

Trusted Certificate Configuration

[mZCen

CX2 self-signed certificate

[Certificate Summary
[Certificate ID: cx2Cert
Description Certificate: lofl 3
Version: 2
Issuer:
+Common Name:CX2 Certificate
+Organization Unit:France Labs 3
*Mrnani i
-
Ok | [ cancel | [ Help

IBM: Sterling Secure Proxy

Configuration Monitoring

Credentials Advanced

System

Credentials
w Certificate Stores
- Trusted Certificate Stores
dfitTrustStore
I [zz System Certificate Stores
I = SSH Key Stores
b { User Stores

Refresh Tree

Actions T

* Trusted Certificate Store Name:
Description

Software Keys

Trusted Certificate Store Configuration

[afitTrustStore

Default trust store

Filter by Name l ]

Name * | Valid To Date * | Description L

7| exlCert 2012-09-04 03:14:42 PM CX1 self-sighed certificate

) | cx2Cen 2012-09-04 03:14:42 PM CX2 self-signed certificate

) | sspDefaultTrustedCert | 2032-11-04 03:02:28 AM ssp default trusted certificate
New | [ Edit | [ Copy | [ Delete |

.

| Save | ‘Canoel ‘ | Help |

Click the Save button to save the configuration. The CX1 and CX2 certificates are now installed in the trusted certificates store.

Import the self-signed certificates in Connect:Express

The place where C:X for UNIX and C:X for Microsoft Windows look up certificates is different: C:X for UNIX has its own certificates
store while C:X for Microsoft Windows uses the operating system certificates store. For that reason, the way to import certificates differs

depending on C:X type.
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Import the self-signed certificates in C:X for UNIX

For this tutorial, 2 certificates need to be installed in this C:X instance: the CX1 and the SSP certificate self-signed. To import these self-
signed certificates the following must be done.

¢ Under the user who is running Connect:Express for UNIX copy the files sspCert.pem and cx1Cert.pem created previously
(Creation of the self-signed certificates for SSP and C:X instances) in the directory
$TOM_DIR/config/ssl/cert_import/

¢ The same way copy the file cx1Key . pem in the directory $TOM DIR/config/ssl/priv/.
¢ Ifitis not running already, start the C:X monitor (command $start_tom).

* Run the C:X operator interface (command $sterm).

C:X/UNIX 158-8
OPTION ===> D

IBM (R) Sterling Connect:Express (R)
Licensed Material - Property of IBM. (C) Copyright IBM

DIRECTORIES MONITOR TABLES 4 REQUEST
PARTNERS STATUS SESSION SSL
FILES LOG PRESENTATION

REQUEST DELETION

¢ Select option 5 SSL.

C:X/UNIX 150-0
OPTION ===> []

N PARAMETERS

IMPORT CERTIFICATES

CERTIFICATE PROPERTIES

4 CONTROL OF CERTIFICATES

-F3- END

¢ Select option 2 IMPORT CERTIFICATES.
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IMPORT
LIST

UPDATE
DELETE

VIEW

-F3- END

¢ Select option I IMPORT, enter SSPCERT for the ID and press the ENTER key.

C:X/UNIX 158-0
OPTION ===> 1

IMPORT
LIST
UPDATE
DELETE
VIEW

-F3- END

¢ Enter ¢ for TYPE, 1 for the FORMAT, set the FILE CONTAINING THE CERTIFICATE TO IMPORT to sspCert.pem, press ENTER
and atthe DO YOU WANT TO GO ON ? prompt press the ENTER key.

C:X/UNIX 158-08
OPTION ===>

(P:PERSONAL,C:CA)
CERTFICATE FILE FORMAT : 1 (1:PEM, 2:DER)
FILE CONTAINING THE CERTIFICATE TO IMPORT :
sspCert.pem

KEY FILE FORMAT = (1:PEM, 2:DER)
FILE CONTAINING THE PRIVATE KEY TO IMPORT (PERSONAL CERTIFICATE) :

PRIVATE KEY PASSWORD (PERSONAL CERTIFICATE) :

ORD AGAIN

DO YOU WANT TO GO ON ?I
-ENTER- NEXT FIELD -F3- CANCEL -F8- COMPLETION

* If the certificate has been successfully imported the IMPORT CERTIFICATES menu must be displayed back.
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¢ Select option I IMPORT, enter CX1CERT for the ID and press the ENTER key.

C:X/UNIX 158-8
OPTION ===> I

IMPORT
LIST

UPDATE
DELETE

VIEW

* Set TYPE to P, FORMAT t0 1, FILE CONTAINING THE CERTIFICATE TO IMPORT to cxlCert.pem, KEY FILE FORMAT to 1,
FILE CONTAINING THE PRIVATE KEY TO IMPORT to cxlKey.pem, the PRIVATE KEY PASSWORD accordingly, press ENTER
and at the DO YOU WANT TO GO ON? prompt press the ENTER key.

C:X/UNIX 150-8

OPTION ===>

ID

TYPE N (P:PERSONAL,
CERTFICATE FILE FORMAT : 1 (1:PEM, 2:DER)
FILE CONTAINING THE CERTIFICATE TO IMPORT
cxiCert.pem.

KEY FILE FORMAT t 1 (1:PEM, 2:DER)

FILE CONTAINING THE PRIVATE KEY TO IMPORT (PERSONAL CERTIFICATE) :
Wl ccococoocanocoacaccanhoocoacacscoa: NONOONONONNE NS R

DO YOU WANT TO GO ON ?I E
-ENTER- NEXT FIELD -F3- CANCEL -F8- COMPLETION

* If the certificate has been successfully imported the IMPORT CERTIFICATES menu must be displayed back. Press L LIST to
display all the imported certificates.

<- -F18- -F3- END -F7- PREVIOUS SCREEN -F&- NEXT SCREEN

12/66



PeSIT file transfer with IBM Sterling Secure Proxy

Import the self-signed certificates in C:X for Microsoft Windows

For this tutorial, 2 certificates need to be installed in this C:X instance: the CX2 and the SSP self-signed certificates. The cx2Cert.pl2
and sspCert.pemn file which has been created previously in the paragraph Creation of the self-signed certificates for SSP and C:X

instances must be accessible from the C:X host. To import the certificates the following must be done.

* Importing a certificate in the operating system certificates stores requires the use of the Microsoft Management Console
application. Click the Start button, select Run... and enter mmc.

¢ Select File > Add/Remove Snap-in...

‘i Consolel

Options. .

1 CHWINDOWSY, .\ comprgmt. msc
2 CHWINDOWS system32idfrg. msc

Exit

_ Type the name of a program, folder, document, or
3 Internet resource, and Windows will open it For vou,

Open:

]

] [ Cancel

0]

] [ Browse,

| ‘ Action  Miew  Favoribes  Window
New Chrl+h
Tpen... Chrl+O
Save Ctrs
Save As,

ChrkHM

Help

There are no items to show in this view,

¢ Select Add... button.

Enables you to add snap-ins ta or remove them fram the snap-in console.
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Add/Remove Snap-in

Standalone ‘ Extensions

Use this page to add or remove a stand-alone snap-in from the console,

Snap-ins added to: |a Consale Root

Description

¢ Select Certificates and click the Add button.

Add Standalone Sna)

Avwailable standalone snap-ins:

Snap-in
aﬁnctwex Conkral

@Compnnant Services
lgComputer Management
& Device Manager

BtDisk Defragmenter
gDisk Management
Event Wigwer

[CFolder

Group Policy Object Editar

Micrasoft Corporation
Micrasoft Corporation
Micrasoft Corporation
Micrasoft Corporation
Micrasoft Corporation
Micrasoft Corp, Execut...
Microsoft and VERITAS. .,
Micrasoft Corporation
Micrasoft Corporation
Micrasoft Corporation v

|2

Description

The Certificates snap-in allows wou to browse the contents of the
certificate stores for vourself, a service, or a computer,

¢ Select Computer account.

Certificates s

Thiz snap-n will always manage certificates for:
() My user acoount
(O Service account

(%) Computer account
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¢ Select Local computer and click the Finish button.

Select Computer

E5)

Select the computer you want this snap-in to manage.
Thiz snap-in will ahvaps manage:

(%) Local computer: [the computer this console is wnning on)

() Another computer | Browse. .

[ Allows the selected computer ta be changed when launching from the command ine. This
only applies if you save the console

< Back H Firish }[ Cancel

¢ Click the Close button.

Add/Remove Snap-in

Standalone ‘ Extensions

Use this page to add or remove a stand-alone snap-in from the console,

Snap-ins added to: |a Console Root W

@Certiﬁcates {Local Computer)

Description

Remove About. .,

¢ Click the OK button.
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‘il Consolel

File  Action  Wiew Favorites

o @mB E@m

‘i Console Root

Window  Help

Mame

@ Certfficates (Local Computer) @Certiﬁcates (Lacal Computer)

Expand Certificates > Trusted Root Certification Authorities. Right click on Certificates and select All Tasks > Import...

‘il Consolel

File  Action  Wiew  Favorites

& @ B @

Console Root
D Console Root

Window  Help

Hame

B@ Certificates (Local Computer) Certificates (Local Computer)

Personal

Trusted Roat Certification Authorities

l:l Enterprise Trus
(03 Intermediate
(2 Trusted Publish
[ Untrusted Certi

(23 Trusted Peaple
[ spc

£ i

Mew indow From Here
Refresh

Help

Add a certificate to a store

Click the Next > button.
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* Set the File name field with the full path name of the sspCert. pem file (use the Browse... button if necessary).

¢ Click the Next > button.

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certificate trust
lists, and certificate revacation lists From wour disk to a
certificate store.

A certificate, which is issued by & certification autharity, is
a confirmation of your identity and contains information
used to protect data or ko establish secure network:
connections. & certificate store is the system area where
certificates are kept,

Ta continue, dick Mest,

Certificate Import

File to Import
Specify the File you want ko impart.

File name:
CiitmplsspCert. pem

Mote: More than one certificate can be stored in a single file in the Following formats:
Persanal Information Exchange- PECS #12 (.PF%, P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates {,P7E)

Microsoft Serialized Certificate Store (.SST)

[ = Back ” Next = 1[ Cancel ]

Certificate Store

Certificate stores are system areas where certificates are kept.

‘Windowes can automatically select a certificate store, or you can specify a location For
(O) utomatically select the certificate store based on the type of certificate
(®) Place all certificates in the Following store

Certificate store:

Trusted Root Certification Authorities

[ < Back ” Next > 1[ Cancel ]

* Check that Place all certificates in the following store is selected and points to the Trusted Root Certification Authorities.

Click the Next > button.
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Wizard

wizard,

Completing the Certificate Import

You have successfully completed the Certificate Import

you have specified the follawing settings:

=

Certificate Store Selected by User  Trusted Root Certific,

Contenk Certificate

File Mame Yiwboxsyrirootitmpls)

L3 >
[ < Back ” Finish 1 [ Cancel

¢ Click the Finish button. A dialog box should report the success of the import.

Certificate Import Wizard @

.
1 ) The import was successful,

¢ Click the OK button. The SSP Certificate should appear in the Certificates list of the Trusted Root Certification Authorities.

i Certificates
File windove

&

Action  View  Favorites Help

$ B X B @m

(Z3 console Root
=) Certificates (Local Computer}
123 Personal
=[] Trusted Root Certification Autharities
{24 Certificates
[:I Enterprise Trust
(23 ntermediate Certification Authoritiss
|2 Trusted Publishers
(2 Unkrusted Certificates
(23 Third-Party Root Certification Authoritie
|2 Trusted People

(21 5PC

< e

Issued To
[Elsecureniet CA Class &
[Elsecurenet CA Class B
[Elsecuretiet CA Root
[Elsecurehiet CA SGC Root
SecureSign RookCal
SecureSign RookCaz
SecureS|gn RootCAa3

[ElSERVICIOS DE CERTIFICACION - ...

[E 514 secure Client Ca
[Es14 secure Server CA

[E swisskey Root A

[EA7C TrustCenter Class 1 CA

[EA7C TrustCenter Class 2 CA

[EA7C TrustCenter Class 3 CA

[ETC TrustCenter Class 4 Ca

TC TrustCenter Time Stamping Cé
(& thawte Personal Basic CA

[El thawte Personal Fresmai CA

<

Issued By

SecureMet CA Class &
SecureMet Ca Class B
SecureMek CA Rook
SecureMek CA SGC Rook
SecureSign RootCAL
SecureSign RookCAz
SecureSign RootCAS
SERYICIOS DE CERTIFICACION - A....
518 Secure Client CA
SIA Secure Server CA

Swisskey Rook CA

TC TrustCenter Class 1 Ca

TC TrustCenter Class 2 Ca

TC TrustCenter Class 3 CA

TC TrustCenter Class 4 CA

TC TruskCenker Time Stamping C&
Thawte Personal Basic CA
Thawte Personal Freemall CA

Expiration Date
10/16/2009
10162009
10162010
10162009
9/1512020
9/15/2020
9/15/2020
3f9/z009
7l9fz019
719)2019

1/1)2018
1/1)2011
1/1)2011
1/1)2011
1j1j2011
1j1j2011
1j1j2021
1j1j2021

Inten
Secure
Secure
Secure
Secure
Securt
Secure
Secure
Securt
Secure
Securt

Secure
Securt
Securt
Secure
Securt
Time £
Client
CllenF 32

¥

Trusted Root Certification Authorities store contains 109 certificates,

* Expand Certificates > Personal; right click on Certificates and select All Tasks > Import... (if there are no certificates already

installed then right-click Personal).
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‘i Certificates
File  Action View Favorites  Window  Help

e BE £HE

i Console Root\Certificates (Local Computer)\Personal

|23 Consale Roat
= Certificates (Local Computer)

m

(23 Trustes Find Certificates...

[0 Truster  Mews Window from Here
Unkrus

8 Third-f  Mew Taskpad View...

[ Trustey  pefresh

D sPC Export List...

Help

<

Chbject Type

There ate no iterns to show in this view,

Find Certificates. ..

Reequest Mew Certificate. ..

Add a certificate to a store

¢ Click the Next > button.

icate Import Wizar X ‘

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certificate trust
lists, and certificate revacation lists From your disk to &
certificate store.

A certificate, which is issued by a certification authority, is
& confirmation of your identity and contains information
used ta protect data or to establish secure netwark
connections. & certificate store is the system area where
certificates are kept,

To continue, dlick Hext.

¢ Set the File name field with the full path name of the cx2Cert.p12 file (use the Browse... button if necessary).

Cer

File to Import
Specify the

File name:

ate Import Wizard &

file: wou want ta impart,

Ci\tmpox2Cert pl2 | [ Browse. ..

Personal

Mote: More than one certificate can be stored in a single file in the Following Formats:

Cryptographic Message Syntax Standard- PKCS #7 Certificates {,P7E)

IMicrosaoft Serialized Certificate Stare ((55T)

Infarmation Exchange- PECS #12 {,PFX, P12)

< Back. H Mext = 1[ Cancel
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¢ Click the Next > button.

Certificate Import Wizard

X

Password

To maintain security, the private key was protected with  password.

Type the password for the private key.

Password:

|=«n<**>«m«|

[] Mark this kery as expartable. This will slow you to back up or transport your
keys at  laker kime.

< Back ” Next = I[ Cancel

* Set the Password with the private key password and click the Next > button.

Certificate Import Wizard El

Certificate Store

Certificate stores are system areas where certificates are kept.

‘Windows can automatically select a certificate stare, or you can specify a location For
() Aukomatically select the certificate store based on the type of certificate
() Place all certificates in the Following store

Certificate store:

Fersonal Browsg...

[ < Back ” Mext = 1[ Cancel

¢ Check that Place all certificates in the following store is selected and points to the Personal certificate store. Click the Next >
button.

cate Import Wizard ﬁl

Completing the Certificate Import
Wizard

‘fou have successfully completed the Certificate Import
wizard.

‘ou have specified the following settings:
Certificate Store Selected by User  Personal

Cantent
File: Mame Ctmplox2Cert.pl2
< b

[ < Back ” Finish 1' Cancel

¢ Click the Finish button. A dialog box should report the success of the import.
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Certificate Import Wizard

.
\1 ) The import was successful,

¢ Click the OK button. The CX2 Certificate should appear in the Certificates list of Personal.

‘i Certificates

File  Action Wiew Faworites  ‘Window  Help

@ TmE YR XEFE 2B

‘i Console Root\Certificates (Local Computer)\Personal\Certificates
[ Console Raot
E@ Certificates (Local Computer)
=23 Personal
123 Certificates
(2 Trusted Rook Certification Authorities
i (2] Certificates
D Enterprise Trust
(23 Intermediate Certification Autharities
(23 Trusted Publishers
(£ Untrusked Certificates
(23 Third-Party Root Certification Authoritic
(23 Trusted People
w1 sPC

Issued To Issued By Expiration Date Intended

<

Personal store contains 1 certificate.

* Close the Microsoft Management Console. Click the No button to not save the console settings (the certificates will remain
installed).

Microsoft Management Console

' Save consale settings to Certificates. msc?
LI

es | Mo I Cancel
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Configuration

This section explains how to configure the C:X instances and SSP.

Configure Connect:Express for Unix

In order to do a secured file transfer to another C:X instance we need to create a few Connect:Express objects. The required certificates
should have been already installed as described in the section Import the self-signed certificates in C:X for UNIX.

Define the client SSL session

Even if we will not use SSL client authentication in this tutorial, C:X for UNIX requires to define a client session.

¢ Ifitis not running already, start the C:X monitor (command $start_tom).

¢ Run the C:X operator interface (command $sterm).

C:X/UNIX 150-8
OPTION ===> []

IBM (R) Sterling Connect:Express (R)
Licensed Material - Property of IBM. (C) Copyright IBM Corp. 1999

DIRECTORIES
PARTNERS

FILES

¢ Select option 5 SSL.

C:X/UNIX 150-0
OPTION ===> []

¢ Select option 1 SSL SESSION PARAMETERS.

MONITOR _ 3 TABLES _ 4
STATUS
LOG SENTATION

REQUEST DELETION

-F3- END

1 SSL SESSION PARAMETERS

IMPORT CERTIFICATES

CERTIFICATE PROPERTIES

4 CONTROL OF CERTIFICATES

-F3- END
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C:X/UNIX 15@-8
OPTION ==

SL ON PARAMETERS

IMPORT CERTIFICATES

CERTIFICATE PROPERTIES

CONTROL OF CERTIFICATES

-F3- END

¢ Select option A ADD. Set the ID to CX1CLI. Press the ENTER key.

C:X/UNIX 150-8
OPTION ====> A

-F3- END

¢ Set the STATE to E, MODE to C, VERIFY OPTIONS to 0, CERTIFICATE ID to CX1CERT, TLSV1, SSLV2 and SSLV3 to Y, leave the

IP HEADER setto N. Atthe DO YOU WANT TO GO ON? prompt press the ENTER key.

:ENABLED, H: DISABLED)

LIENT ERVER)
(©:NONE, 1: PEER
2:PEER + FATL_TF_NO_PEER_CERT)

(LIST FILE NAME)

RT-ID', #LIST)

(
(FILE NAME)

TCP PORT :

DO YOU WANT TO GO ON ﬂ]
-ENTER- NEXT FIELD

-F3- CANCEL -F8- COMPLETION

* Press F3 to go back to the MAIN MENU.
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Define the partner CX2

We need to define the partner to which we will send the file.
¢ From the MAIN MENU select option 1 DIRECTORIES PARTNERS FILES.

C:X/UNIX 158-8
OPTION ===> []

PARTNERS DIRECTORY MANAGEMENT

1 P-PARTNE

FILES DIRECTORY MANAGEMENT

-F3- END

¢ Select option 1 P-PARTNERS.
* Select option A ADD and set PARTNER to CX2SSL. Press the ENTER key.

C:X/UNIX 158-8
OPTION ===> A

LIST
UPDATE
DELETE
VIEW

PARTNER

-F3- END

¢ Set PASSWORD to CX2SSL, INITIALIZATION STATUS to E, PARTNER TYPE to O, PROTOCOL NUMBER to 3,
SESSION TABLE NUMBER to 1, MAX NO. CONNECTIONS to 05/05/10, TYPE OF CONNECTIONS to T, TCPIP HOST 0 ssp,

TCPIP PORT t0 16100, DPCSID ALIAS to CX1SSL, SSL PARMID to CX1CLI, DPCPSW ALIAS to CX1SSL,
NUMBER OF RETRIES to 02, INTERV.SESS to 01. At the DO YOU WANT TO GO ON? prompt press the ENTER key.
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DIRECTORY

P WORD OF PARTNER
E:ENABLE H:DISABLE
T/0

1->9
= X25 DEVI
05/05/10 64 TOT/IN/OUT
T P, TOR M
X25 DIAL NUMBER -
. 1-15 CHARACTE
' R-DATA-FIELD'

PORT . : 16100
DEF FTP FILE .. : . scco
LPARM ID

W ALI - CONTROL OF
NUMBER OF RETRIES . = E INTERV.

DO YOU WANT TO GO ON ?I E
-ENTER- NEXT FIELD -F3- CANCEL -F8- COMPLETION

* Press F3 to go back to the MAIN MENU.

Define the file definition
The last object to define is the characteristics a the file to transfer.
¢ From the MAIN MENU select option 1 DIRECTORIES PARTNERS FILES.

C:X/UNIX 150-0 - - DIRECTORIES MANAGEMENT -
OPTION ===> []

PARTNERS DIRECTORY MANAGEMENT

FILES DIRECTORY MANAGEMENT

¢ Select option 2 F-FILES.

* Select option A ADD and set FILE to TEST. Press the ENTER key.
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C:X/UNIX 158-@
OPTION ===> A

-F3- END

¢ Set INITIALIZATION STATUS to E, DIRECTION {0 *, RECEIVING PARTNER {0 $SALLSS, TRANSMITTING PARTNER {0 $
$ALLS$S, PRIORIY to 2, DEFINITION TYPE to D, PRESENTATION TABLE to 1, PARAMETER CARD FILE to N,
SPACE TO RESERVER {0 N, ALLOCATION RULE {0 0, PHYSICAL NAME {0 /tmp/TEST_ &REQNUMB.txt, RECORD FORMAT to B*,
DEFINITION TYPE fo D, RECORD LENTGH to 512. Leave the parameters to the default by pressing the ENTER key.

C:X/UNIX 158-8
OPTION ===>

SYMBOLIC NAME

INITIALIZATION STATUS . : E:ENABLE H:DISABLE
DIRECTION ... : T:TRANSMIT R:RECEIVE *:EITHER
'NAME', #LISTE, $SALLS
E, SSALLSS
E 2: NORMAL
: :DYNAMIC F:FIXED
PRESENTATION TABLE .... : 1 i 9 PRESENTATION TABLE

N
:INDIF., 1:PREALL., 2:TO CREATE
/tmp/TEST_&REQNUMB . txt
RECORD FORMAT . B* TF, TV, BF, BU, T*, B*, **
RECORD LENGTH ... pes512 1-5 NUMERIC CHARAC.
REMOTE DSN (FTP) ... 2
TYPE/STRUCTURE/MODE FTP : *** E I/*
STORE UNIQUE (FTP) .... : N Y/N FA :

H = UPD : 11/09/88 10:00 bTn
-ENTER- NEXT FIELD -F3- CANCEL -F8- COMPLETION

The physical name of the file is /tmp/TEST &REQNUMB.txt. &REQNUMB is a variable which will be replaced by the request
number when the transfer request will be executed.

¢ On the next screen, press the F8 key. At the DO YOU WANT TO GO ON? prompt press the ENTER key.
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C:X/UNIX 158-8 FILES DIRECTORY

> NAME

DEFINITION : D DIRECTION :

UPD : 11/09/08 08:00 bfn
-F3- CANCEL -F8- COMPLETION

At this point the configuration is finished to be able to transfer the file TEST to the CX2 partner.

Define the server SSL session

Because we want CX1 instance to be able to accept inbound connections, it must be configured as a server as well
¢ Ifitis not running already, start the C:X monitor (command $start_tom).

* Run the C:X operator interface (command $sterm).

IBM (R) Sterling Connect:Express (R)
Licensed Material - Property of IBM. (C) Copyright IBM Corp. 1999

DIRECTORIES _ MONITOR

TABLES _ REQUEST

PARTNERS STATUS e

FILES LOG NTATION

REQUEST DELETION

-F3- END

¢ Select option 5 SSL.
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C:X/UNIX 158-8
OPTION ===>[]

E ON PARAMETERS

IMPORT CERTIFICATES
CERTIFICATE PROPERTIES

4 CONTROL OF CERTIFICATES

-F3- END

¢ Select option 1 SSL SESSION PARAMETERS.

C:X/UNIX 158-8
(OPTION =

L ON PARAMETERS
IMPORT CERTIFICATES
CERTIFICATE PROPERTIES

4 CONTROL OF CERTIFICATES

-F3- END

¢ Select option A ADD. Set the ID to CX1SRV. Press the ENTER key.

---SSL SESSION PARAMETERS- -

-F3- END

¢ Set the STATE to E, MODE to S, VERIFY OPTIONS to 0, CERTIFICATE ID to CX1CERT, CYPHER LIST blank, TLSV1, SSLV2 and
SSLV3 to Y, NETWORK to T, IP ADDRESS blank, TCP PORT to 5100, leave the IP HEADER set to N. At the DO YOU WANT TO GO
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ON? prompt press the ENTER key.

C:X/UNIX 158-08
OPTION ===>

( ERVER)
(©:NONE, 1: PEER
2:PEER + FAIL IF NO PEER CERT)

(LIST FILE NAME)

("CACERT-ID', #LIST)
(FILE NAME)
(SERVER MODE)

TCP PORT :

DO YOU WANT TO GO ON ﬂ]
-ENTER- NEXT FIELD -F3- CANCEL

-F8- COMPLETION

At this point the configuration is finished. Press F3 to go back to the MAIN MENU. For the new server to be enabled, you stop and restart
Connect:Express.

Configure Connect:Express for Windows

To do a secured file transfer to another C:X instance we need to create a few Connect:Express objects. The required certificates should
have been already installed as described in the section Import the self-signed certificates in C:X for Microsoft Windows. The
creation of the configuration objects is done using the CX Graphical Interface and the CX Monitor must be running. Do the following.

¢ Launch CX Monitor from the Start menu: All Programs > CONNECT Express > CX2 > CX Monitor.

;’HCnnnecl:Express - File transfer... g@]g|
V31.001

MONITOR INITIALISATION IN PROGRESS...
THE MONITOR IS STARTED

¢ Launch Graphical Interface from the Start menu: All Programs > CONNECT Express > CX2 > CX Graphical Interface.
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;ﬁConnect:Express - Graphical Interface
File Edit “iew Window 7

3| 2% &lx] 2]

§% ConrectExpress

Faor Help, press F1

I I

Create the monitor instance CX2

The first object to create is the monitor instance CX2.

* On the left pane, right-click Connect:Express > New > Monitor.

i) Connect:Express - Graphical Interface

File Edit ¥iew Window ?

o] 28] (x| 1

5 " Cannhect Expreg

Manage... Chrl+A
Configure... Chrl+F

Exit

* Set the Name to CX2, optionally the Description, the Initialization file name to tomnt.ini (use the Browse... button to find the

file in the C:X installation directory), tick the TCP/IP check box, set the Host name to cx2 and the Port to 7000.

New monitor, definition

~ Monitor information

Wame: |D<2

Comment: |CX2 Partner

Initialization file narme: IE'\Dexpress\tnmnl ini

Browse...

~ Nebwork information

¥ TCPAP

I Named pipe

Host narme: chZ

Address: l_ l_ I_ I_
Part : 7000

Name: I

Ok

[ ox |
Cancel

The host name must be the same as the host where the CX Monitor is running. The CX Graphical Interface enables to manage
remote C:X instances. The port value is the default from the installation.
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* Click OK.

Create the client SSL session
Even if we will not use SSL client authentication in this tutorial, C:X for Windows requires to define a client session.

* Expand the CX2 node in the left pane and double-click on Management. Sign in using ADMIN for both the Client and the

Password.
E Connect:Express - Graphical Interface
File Edit View ‘Window 7
‘8| Bl%| =[x 2|
E‘jg Connect:Express
B
=] Management
% Configuration Bliie SDHN
Password ]
cacal_|
Note:

O The CX Graphical Interface establishes a connection with the CX monitor. This connection has a timeout and in case of
inactivity the connection will be stopped. If it happens at some point of a configuration operation, you will see the following
message box.

3
WA ) The conneckion with the monitor was lost because it was inactive for koo long, Do you want ko be automatically reconnected #

es Mo

Just click the OK button and your work will continue normally.

¢ In the middle pane select Directories > SSL Clients then double-click on New SSL Client in the right pane.
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s Connect:Express - Graphical Interface - [Management - Monitor: CX2 - Client: ADMIN] X
File Edt Wiew Management ‘Window ? -8 x

5] =] x| 2|

o Transfer Monitor - Connect:Ex | Mame N
=144 ConnectExpress El n Directories £ few 551 Clisnt =
Bk 02 8 Partriers e

=3l Management o Files
% Configuration W Clierts
L ] e

‘ Activity
Messages
& Tournal
& Notifications
= % Parameters
] % Manitor
% Metworks
% 550 Servers
= % Tables
| % PeSIT
% Session
% Presentation
| % Etebac-3
% Presentation

2.0 |9/@@ |||

2,

lad

iz,

& |&ld |2

|~
v
|~
v

For Help, press F1

¢ Set the Name to CX2CLI, ensure the Enabled check box is ticked, select Protocol SSL V3.0, Store provider
STORE_PROV_SYSTEM, Store location SYSTEM STORE_LOCAL MACHINE, set Store provider to My, Subject DN to
CX2 Certificate.

SSL client properties:CX2CLI &\

General ] Cipher suites 1

(5 o

Status; v Enabled [ Data are prefied with 2 bytes length
Protocol TS V1.0 * 55Lv3.0 ™~ §5Lva0
Trace * Nons " Medium  Ful

Certificate store

Stare provider |STORE_FROW_SYSTEM ~|
Store loeation: |5**STEM_STORE_LOCAL_MACHINE ~|
Store hame: ‘My

Certificate name:
Subject DM:
|02 Centificate

Issuer DN:

akK | Cancel I Help

¢ Click the Next button. Click the Add All button.
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£

Cipher suites

Available: Selected

TLS_ASA_WITH_RCA_125 MDS
TLS_RSA WITH_RC4 126 SHA
TLS_RSA_WATH_3DES_EDE_CRC_SHA
TLS_RSA_WITH_DES_CBC_GHA
55L_CK_FC4 128 WITH_MD5
S5L_CK_DES_A4_CEC_WITH_MD5

SSL_CK_RC2_128 CBC_WITH_MDE
Remave All

< Back | Finizh Cancel Help

¢ Click the Finish button.

Create the partner CX1

We need to define the partner to which we will send the file.

¢ In the middle pane select Directories > Partners then double-click on New Partner in the right pane.

;HCnnner:l:[xpress - Graphical Interface - [Management - Monitor: CX2 - Client: ADMIN]

File Edit View Management ‘Window 7 _ 8 x
u| =% F]x| 2
o Transfer Monitor - Connect:Ex | Mame
=& ConnectExpress J =) Directories | &l hew Partner
=5 o oo rtners ®Loop
M anagement ™ Files
Configuration o Clients
550 Clients
= 1= @ Manitor
& Requests
& Activity
‘ Messages
m ‘ Journal
(5] & notifications
~1|= % Parameters
] = 48 Manitor
= 88 Metworks
5‘3 % S5L Servers
i -4 Tables
9 ) 8t pesIT
7 % Session
L] 4 Presentation
& -8 Etebac-3
= Presentation
= B
“
Y
k]
< | 3]s >
For Help, press Fi

¢ Set the Name to CX1SSL, optionally a Comment, the Local name to CX2SSL, Local password to CX2SSL, leave the
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C:X monitor check box non ticked.

¢ Click the Next > button. Tick the Use SSL box, set the Client parameter definition to CX2CLI.

General

Thiz wizard will help pou add a new partner definition:

ﬁ Mame: [CX1550

Comment: |E><1 Partner

Paszsword: |C:155L0

[ Dynamic local identification

. Laocal
Local name: CH2550 password CH255L
Statuz: W Enabled Pratocal: € PeSIT D
¥ Automatic resume * PeSITE'
" ETEBAC3
Mext » Cancel | Help

Partner Properties: CX1S5L
General 3SL ] Sessinn} Netwnrk]

v Use SSL Client parameters definition :

Cx2CLI

Remote Client DM control

Fiemote client subject dn: |

Trusted root dr: |

Remate Server DN control

Remote server subject dn |

Trusted root dr |

X

QK ‘ Cancel | Help

¢ Click the Next > button. Set Incoming
PeSIT session (TCP/IP).

to 5, Outgoing to 5, Total to 10, in the Session tables list select

34/66



PeSIT file transfer with IBM Sterling Secure Proxy

Session ['>__<|
Nurnber of connections:
Incoming: |05 Outgaing: |05 Tatal. |10
Selected session
table name: PeSIT session [TCPAP)
Session tables st
< Back Mext > Cancel Help
¢ Click the Next > button. Set the Host name to ssp, the Port to 16200.
Network [z|
* TCPAP
Host name:
Address: . . Port; (16200
 LUB2
LU narne: Mode narne:
Tranzaction pragram
hame: |
%25
Local Femote
address: address:
User data: Part: :I
Facilities:
< Back Finish | Cancel Help

¢ Click the Finish button.

Create the file definition

The last object to define is the characteristics of the file to transfer.

* In the middle pane select Directories > Files then double-click on New File in the right pane.
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5] Connect:Express - Graphical Interface - [Management - Monitor: CX2 - Client: ADMIN]
File Edit View Management ‘indow ? mEES

Caf =% @] 2

IS Transfer Monitor - Connect:Ex [ Hame
=4 CornectExpress = Directories e Fils
=B ox2 9 Partners FIE
Management - Y]
Configuation ® Clents
€ 350 Clients
—| = & moniter
& Requests
Activity
5 =3
& Messages
(o) & Journal
& Hotifications
— | = % parameters
(=] =1 4 Moritar
g Networks
= %
T‘ﬁ g 5SL Servers
b =%y Tables
97 =48 pesiT
7 B Session
- 4 Presentation
& = 4 Etebac3
| Presentation
=l B
S
Fa
|
< e £ >

For Help, press F1

¢ Set the NAME to TEST, optionally the Comment, the File name to C: \tmp\TEST &REQNUMB. txt (the file name will be
explained later), in List of PeSIT presentation table select PeSIT presentation without compression.

< Thiz wizard will help you add a new file definition

| Mame : TEST ¥ Enabled

Comrment: |Test pLIpose
™ Fixed File name: |C:\tmp\TEST_&HEQNUMB.txt Browse ...

Label: |

Selected presentation PeSIT presentation without compression

table narme:

List of PeSIT prezentation tables List of ETEBAC-3 prezentation tables

FPeSIT prezentation with horizontal compression ETEBALS presentation with tranzlation

PeSIT presentation with mised compression ETEBALCS presentation without translation
presentation with vertical compression

\PeSIT

PeSIT p ation withaut compr h
With tranglation and without compression

P33
TRAMSMISSION

Offzet : ’—ﬂ Walue : |
RECEFTION

Offset : ﬂ Walue : |

| Mext » | Cancel Help

¢ Click the Next > button.

¢ Tick the Transmission check box, select $$SAPISS in the list, tick the Reception check box, select $SSAPISS in the list, click the
New radio button in the Open action box, click the Undefined radio button in the Binary box, set the Size of articles to 512.
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Transfer rules

W' Transmission

CK155L
LooP

Selected receiver:

Transfer direction :

Iv¥ Reception

CK155L
Loop

< Back | Mest > |

$34PI$E Selected sender: $EAPISE
Open action Article characteristics
WINDOWS text LIMIE text Binary
* Mew " Fixed " Fixed " Fixed
" Replace ™ Wariable ™ ariable (+ Undefined
Size of articles: 512

Cancel

Help

¢ Click the Next > button.

Leave the Notification check box non ticked.

Notification

Selected client name:

< Back | Mest > |

Cancel Help

Click the Next > button.

Leave of the fields blank.
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Commands

TRANSMISSION

Begin:

Browse...

End:

Browse...

RECEFTION

Begin:

End:

Browse...

Browse...

ERROR

Browse...

< Back | Mest > |

Cancel Help

¢ Click the Next > button.

Exits

TRANSMISSION

Beqin: |

End: |

RECEFTION

Begin: |

End: |

< Back Cancel Help

¢ Click the Finish button.
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Define the SSL server

Because we want CX2 instance to be able to accept inbound connections, it must be configured as a server as well. This is done with
the CX Graphical Interface.

* In the left pane expand the CX2 node and double-click on Configuration. Sign in using ADMIN for both the Client and the
Password.

8] allw| 1] 2]

=14 Connect Express
=Bl CA2
E Management

% Configuration

Clignt

Password:

Cancel

e T

\ 019D BIX|E B e

¢ In the right pane select SSL Servers and double-click on New SSL Server.

B Connect: Express - Graphical Interface - [Configuration - Monitor

Q:g File Edit “iew Configure “Window ?
5] Fl8] @i 3
=-f5 ConnectExpress

C=2

g Management
%y Configuration

¢ Set the Name to CX2SSL, ensure the Status Enabled check box is ticked, set SSL server port to 5100, clear the
Client authentication check box, clear the Data are prefixed with 2 bytes length, select Protocol TLS V1.0, Store provider
STORE_PROV_SYSTEM, Store location SYSTEM_STORE_LOCAL_MACHINE, set Store provider to My, Subject DN to
CX2 Certificate.

39/66



PeSIT file transfer with IBM Sterling Secure Proxy

Thizs wizard will help you add new ssl server parameters:

Certificate name
Subiject DM:

|‘JS: Mame: |CH255L0
o
Status: W Enabled [ Client authentication S5L server port;  |5100
Protocal : & TLS V1.0 " 55Lv30 " §5Lv20
Trace : & None " Medium " Ful
™ Data are prefized with 2 bytes length
Certificate store
Store provider: [STORE_PROV_SYSTEM -
Stare location: |SYSTEM_STORE_LOCAL_MACHINE |
Store name: |My

|E><2 Certificate
lszuer DN

Cancel

| Next > |

Help

¢ Click the Next button. Click the Add All button.

¢ Click the Finish button.

Cipher suites

Available:

Selected

TLG_RSA_wITH_RCA_126_MD5
TLS_RSA_WITH_RCA_125_SHA

TLS RSA WITH 3DES_EDE_CEC SHA
TLS_RS4_wITH_DES_CBC_SHA
S5L_CK_FC4_128_WITH_MDS
55L_CK_DES_B4 CEC_WITH_MD5
55L_CK_RC2126_CBC_wWITH_MDS

|

A

il
Remove &l

< Back | Firigh

Cancel

Help

X

At this point the configuration of the CX2 instance is finished.
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Configure the secured inbound and outbound nodes in SSP

To enable a C:X instance to securely send a file to another C:X instance through SSP some configuration is required at SSP level. In
particular, the inbound and outbound connections must be configured. Do the following:

* Connect to the SSPcm graphical interface with administrator privileges (the section Import the self-signed certificates in SSP
explains how to connect to the SSPcm graphical interface).

IBM. Sterling Secure Proxy

.||I
Iin

C

e
Monitoring Credentials Advanced System Help Sign Out
Configuration Actions ¥

[ Engines

Adapters

£7 Netmaps

= Policies
e v

Refresh Tree

@ Copyright IBM Corp. 2003, 2011 All Rights Reserved.
* Open the Actions drop down list and select New Engine...

IBM- Sterling Secure Proxy

Monitoring Credentials Advanced System
Configuration Actions ¥ |
[§ Engines New Engine...
Aaapens New Adapter.. ¥
£ Netmaps New Netmap... b
f Policies
NewPolicy...  »

Copy Selected...
Delete Selected...

* Set the Engine Name with sspEngine, optionally the Description and the Engine Host with ssp (host name where SSP will
run), leave the default Engine Listen Port.
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IBM- Sterling Secure Proxy

Configuration

Monitoring

Credentials

Advanced System Help Sign Cut
Configuration Actions 7 Basic Advanced SSP Engine Configuration
# Engines
Acapters * Engine Name: | sspEngine )
£2 Netmaps Description SSP Engine
{5 Policies
* Engine Host: |ssp )
* engre isen on
v
Refresh Tree

© Copyright IBM Corp. 2003, 2011 All Rights Reserved

* Click the Save button. The newly created sspEngine must appear on the left pane as well as a successful message on the right

pane.

IBM: Sterling Secure Proxy

Configuration

Monitoring Credentials

Advanced

System

Configuration
v B Engines
[ sspEngine
Adapters
£% Netmaps
5 Policies

Actions 7

e Engine - Completed

Engine configuration has completed successfully.

* Open the Actions drop down list, expand New Policy... and select PeSIT Policy...

IBM: Sterling Secure Proxy

e

Monitoring Credentials Advanced Systam
Configuration Actions ¥ ‘
= [ Engines New Engine...
B sspEngine NewAdapter.. » |- Completed
apters Y »
2 Netmaps i fonfiguration has completed successfully.
& Policies NewPolicy.. b [C:D Policy..
Copy Selected.. | TP Policy...
Delete Selected... PesIT Policy...

¢ Set the Policy Name to pesitPolicy, optionally the Description. Click the Save button.
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IBM: Sterling Secure Proxy

g Advanced System Help. Sign Out
Configuration Actions = | Basic ‘ Advanced ‘ Transfer Direction ‘ PeSIT Policy Configuration
+ [§ Engines
#* i
5 sspEngine Palicy Name [ pesitPalicy
7@ Adapters Description, PeSIT Policy
£4 Netmaps ‘
{5 Policies
Type: PeSIT
Protocol Error Action: [ NONE ~
) .

© Copyright IBM Corp. 2003, 2011 All Rights Reserved

* Open the Actions drop down list, expand New Netmap... and select PeSIT Netmap...

IBM. Sterling Secure Proxy

Ci Manitoring Credentials Advanced System
Configuration Actions 7 |
b & Engines New Engine...
Adapiers New Adapter..  + Policy - Completed
a8 Nomaps New Netmap. b | C:D Netmap.
= i Policies F;'PN “* |nas completed
. New Policy... b T
2, pesitPolicy HTTP Netmap...
SFTP Netmap...
Copy Selected... PeSIT Netmap...

¢ Set the Netmap Name to pesitNetmap, optionally the Description. Click the New button.

IBM: Sterling Secure Proxy

Configuration

Monitoring Credentials Advanced System Help Sign Out
Configuration Actions ¥ PesIT Netmap
# g Engines * Netmap Name: [ pesitNetmap |
Adapters Description, PesIT Netmap/
£4 Netmaps
+ fiz Policies Type: PeSIT
sy pesitPolicy Netmap Nodes
Fiter: | ]EI
| [ Node Name | Adaress port |
| No netmap nodes configured yet |
[ Wove U | wove Donn e ] (€8] [Gom ] [oeee |
* Required
T ] .

© Copyright IBM Corp. 2003, 2011 All Rights Reserved.
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* In the Basic tab, set the Node Name to in-CX1, optionally the Description, the PeSIT Server Address to cx1*, select the

Policy pesitPolicy. Here, cx1 is the host name from which the node in-CX1 will accept connections. Specifying the wild-card
(*) means that SSP will listen connections from cx1 on all ports. The PeSIT Server Port field is then greyed because we implicitly
specified all the ports. Click the Ok button.

Basic | Security | Advanced PeSIT Netmap Node
Netmap Name: pesitNetmap

Description PeSIT Netmap

* Node Name: in-CX1
Routing Name:

Description: Inbound connection from CX1

* PeSIT Server Address: cxl*
* PeSIT Server Port:

—
“Policy: [pesitPoiicy —'I@ E|

*Required oK | [ caneal | [(rHep |

¢ Select the Security tab and, tick the Use SSL check box, select the df1tTrustStore from the Trust Store drop down list, select

cxlcCert from the CA Certificates/Trusted Root drop down list, select df 1tKeyStore from the Key Store drop down list, select
sspCert for the Key/System Certificate drop down list.

‘ Basic ‘ Security | Advanced ‘ PeSIT Netmap Node
Netmap Name: pesitNetmap
Description: PeSIT Netmap

I Use SSL

Verify Common Name

* Certificate Common Name:

Enable Client Authentication

* Security Setting [SSLvaorTLs
* Trust Store [ dfitTrustStore
* CA Certificates/Trusted Root: ~ [ex1Cert
cx2Cert
sspDefaultTrustedCert
* Key Store [ dfitkeySiore
* KeyiSystem Certificate: [sspcert

Available Cipher Suites:

* Cipher Suites: TLS_RSA_WITH_RC4_128_SHA
TLS_RSA_WITH_RC4_128_MD5
TLS_RSA_WITH_DES_CBC_SHA
TLS_RSA_EXPORT_WITH_DES40_CBC_SHA  *

Selected Cipher Suites:

TLS_RSA_WITH_3DES_EDE
TLS_RSA_WITH_AES_256 (
TLS_RSA_WITH_AES_128 ¢

. L
B S ™

Down

*Required ok | [ cancel | | Help

The cx1cert CA certificate will be used to check that the certificate presented by the client cx1 is trusted. For simplicity we are
not using the client authentication but this information needs to be filled. The system certificate sspCert is the certificate the server
will send to the cx1 client during the SSL handshake. The cx1 client will successfully check that sspCert is trusted if it finds
sspCert in its trusted certificates store.

Click the Ok button.
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PeSIT Netmap
* Netmap Name: |:;:-: tNetmap
Description; PesiT Nemap
Type: PeSIT
Netmap Nodes
Filter:
Node Name Address Port
in-CX1 ex1*
New | [ e | [ Cony | Do |
* Required

¢ Click the New button and, set the Node Name to out-CXx2, optionally the Description, the PeSIT Server Address to cx2, the
PeSIT Server Port to 5100 and select the pesitPolicy in the Policy drop down list.

| Basic | Security ‘ Advanced | PeSIT Netmap Node
Netmap Name: pesitNetmap
Description: PeSIT Netmap
* Node Name outCx2
Routing Name:
Description Outgoing connection o CX2
* PeSIT Server Address: cx2
* PeSIT Server Port 5100
*Policy: [ pesitPolicy (T E
“Required [ ok ] [cancel | [ Help |

5100 is the value of the port on which the CX2 instance is listening incoming SSL connections.

¢ Select the Security tab, tick the Use SSL check box, select the df1tTrustStore from the Trust Store drop down list, select
cx2Cert from the CA Certificates/Trusted Root drop down list, select df 1tKeyStore from the Key Store drop down list, select
sspCert for the Key/System Certificate drop down list.
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‘ Basic ‘ Security | Advanced PeSIT Netmap Node
Netmap Name pesitNetmap
Description PeSIT Netmap
& use ssL

] Verify Common Name

* Certificate Common Name:

"] Enable Client Authentication

* Security Setting [ssLvaorTLs

[
* Trust Store: [dtTrustStore =l
* CA Certficates/Trusted Root: cxlCert
cx2Cert
sspDefaultTrustedCert
* Key Store. dfitKeyStore =l
* Key/System Certificate: sspCert =l
Available Cipher Suites: Selected Cipher Suites:
* Cipher Suites: TLS_RSA_WITH_RCA4_128_SHA Add> TLS_RSA_WITH_3DES_EDE
TLS_RSA_WITH_RC4_128_MD5 TLS_RSA_WITH_AES_256_t
TLS_RSA_WITH DES_CBC_SHA TUS_RSA_WITH_AES_ 12871
TLS_RSA_EXPORT WITH_DES40_CBC_SHA |7 T S
*Required oK | [ cancel | [ Help |
¢ Click the Ok button.
PeSIT Netmap
*Netmap Name:  [pesiiNemmap.
Description PeSIT Nelman
Type PeSIT
Netmap Nodes
Filer: |
Node Name Address Port
in-CX1 cxl*
out-Cx2 cx2 5100
e ] [Est | [cony ] o
*Required (==

* Click the New button and, in the Basic tab, set the Node Name to in-Cx2, optionally the Description, the PeSIT Server Address
to cx2*, select the Policy pesitPolicy and click the Ok button.
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| Basic | Security | Advanced PeSIT Netmap Node

Netmap Name: pesitNetmap
Description PeSIT Netmap

* Node Name [in-cx2 |
Routing Name: I

Description

Incoming connection from CX2 ‘

* PeSIT Server Address; [ex2*

* PeSIT Server Port |

*Policy: [ pesitPalicy ;I@

*Required

oK | [ cancel | [ Help

¢ Select the Security tab, tick the Use SSL check box, select the df1tTrustStore from the Trust Store drop down list, select

cx2Cert from the CA Certificates/Trusted Root drop down list, select df1tKeyStore from the Key Store drop down list, select
sspCert for the Key/System Certificate drop down list.

‘ Basic ‘ Security ‘ Advanced | PeSIT Netmap Node
Netmap Name pesitNetmap
Description: PeSIT Netmap
& Use SSL
) Verify Common Name
* Certificate Common Name:
"] Enable Client Authentication

* Security Setting: [ssLvaorTLs =

* Trust Store: [ aftTruststore =l

* CA Certificates/Trusted Root cxlCert

cx2Cert
sspDefaultTrustedCert

* Key Store: dfitkeyStore El

* Key/System Certificate. | sspCert ;l
Available Cipher Suites: Selected Cipher Suites:

* Cipher Suites: TLS_RSA_WITH_RC4_128_SHA Add> TLS_RSA_WITH_3DES_EDE
TLS_RSA_WITH_RC4_128_MD5 TLS_RSA_WITH_AES_256 (
TLS_RSA_WITH_DES_CBC_SHA TUS_RSAWITH_AES_128_(
TLS_RSA_EXPORT_WITH_DES40_CBC_SHA | v

*Required oK | [ cancel | [ Hep

¢ Click the Ok button.
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PeSIT Netmap
* Netmap Name; |pesilr.emap
Description PeSIT Nelmap
Type PeSIT
Netmap Nodes
Filter: | =]
Node Name Address Port
in-CX1 oxl*
out-Cx2 ox2 5100
in-Cx2 ox2*
New ] [ ] [comy | ool |
[ save | [cancel | [ Hep |
* Required

¢ Click the New button and, set the Node Name to out-CX1, optionally the Description, the PeSIT Server Address to cx1, the
PeSIT Server Port to 5100 and select the pesitPolicy in the Policy drop down list.

| Basic ‘ Security ‘ Advanced ‘ PeSIT Netmap Node
Netmap Name: pesitNetmap
Description: PeSIT Netmap
* Node Name: [out-Cx1 |
Routing Name! [ |
Description: Outgoing connections to CX1 |
* PeSIT Server Address |ext |
* PeSIT Server Port |5100 J
*Policy. [ pesitPalicy =l cp
“Required ok | [cancel | [ Hep |

5100 is the value of the port on which the CX1 instance is listening incoming SSL connections.

* Select the Security tab, tick the Use SSL check box, select the df1tTrustStore from the Trust Store drop down list, select
cx2Cert from the CA Certificates/Trusted Root drop down list, select df1tKeyStore from the Key Store drop down list, select
sspCert for the Key/System Certificate drop down list.
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Click the Ok button.

| Basic ‘ Security

Netmap Name:
Description
s Use SSL

Advanced

pesitNetmap
PeSIT Netmap

PeSIT Netmap Node

(7] Werify Common Name

* Certificate Common Name:

Enable Client Authenti

* Security Setting:

* Trust Store:

* CA Certificates/Trusted Root:

* Key Store:
* Key/System Certificate:

* Cipher Suites:

cation
[ssLvaorTis =l
[ ditTrustStore |
cxlCert
cx2Cert
sspDefaultTrustedCert
diitkeyStore H
sspCert =]
Available Cipher Suites:
TLS_RSA_WITH_RC4_128_SHA Add>

TLS_RSA_WITH_RC4_128_MDS
TLS_RSA_WITH_DES_CBC_SHA

TLS_RSA_EXPORT_WITH_DES40_CBC_SHA

<Remove
Down

Selected Cipher Suites:

TLS_RSA_WITH_3DES_EDE
TLS RSA WITH_AES_256_(
TLS_RSA_WITH_AES_ 128 (

*Required ok | [ cancel | [ Help |
PeSIT Netmap

* Netmap Name; I\]ESI\NEU*IEP

Description PesSIT Nemap

Type: PeSIT

Netmap Nodes

Filter: (
Node Name Address Port
In-CX1 ol
out-Cx2 o2 5100
in-Cx2 ox2*
out-CX1 cxl 5100

New | (ot ] [conv | [ooie |

‘ Save ||Car|oe|| ‘ Help ‘

* Required

PeSIT Netmap
* Netmap Name | pesitNetmap
Description PeSIT Nemap
Type: PeSIT
Netmap Nodes
Filter: [
Node Name Address Port
in-CX1 cxl*
@ |in-cxX2 cx2*

O | outCx2 cx2 5100
out-Cx1 cxl 5100
New | [ & | [ Cony | [ Dol |

‘ Save HCanuE\H Help ‘

* Required

* Because of a known bug in the PeSIT adapter code, the node list must be reorganized. All the incoming nodes must be before the
outgoing nodes. Select the node in-CX2 and click the Move Up button.
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¢ Click the Save button to save changes.

* Open the Actions drop down list, expand New Adapter... and select PeSIT Proxy...

IBM: Sterling Secure Proxy

Ci i Advanced System
Configuration Actions 7 ‘
b [ Engines New Engine...
oy st New Adapter.. b [ C:D Proxy... eted
< £% Netmaps verse
T il NewNemap.. » |FTPReverseProxy. | =~
3 by pesitNetmap HTTP Reverse Proxy...fl" P
25 pesiPolcy New Policy... ¥ | SFTP Reverse Proxy...
b @ Policies PeSITProxy.-
Copy Selecied
Delete Selected...

¢ In the Basic tab, set the Name to cx2PeSITAdapter, optionally a Description, the Listen Port to 16100, select pesitNemap

from the Netmap drop down list, select out-CX2 from the SNODE Netmap Entry drop down list, select sspEngine from the
Engine drop down list.

‘ Basic | et | T PeSIT Adapter Configuration
*Name [cxzPesiTAdapter )
Description, [ PesSIT adapter routing connection to CX2 partner ‘
Type: PesIT

*LisenPort: (16100 J

*Netmap: [ pesitNetmap
Routing Type I Standard *SNODE Netmap Entry: [qut-CX2 =l
Engine: [sspEngine

Startup Mode: auto 7]

Save | ‘ Cancel ‘ | Help

¢ Click the Save button.

* Open the Actions drop down list, expand New Adapter... and select PeSIT Proxy...

| Basic | Advanced | Properties PesSIT Adapter Configuration
* Name: | cx1PesITAdapter |
Description ‘E{gﬁﬂ:anaplermuﬁng connections to CX1 ‘
Type: PeSIT
*ListenPort: (16200 |
*Netmap [ pesitNemap =l E‘
Routing Type: I Standard =] "SNODE Netmap Entry. lm
Engine: [sspEngine = |

Startup Mode: T |

Save ‘ ‘ Cancel ‘ | Help
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Test of file transfers

Everything should be now ready to do a file transfer. We will start with transferring a file from CX1 to CX2 then the opposite.

File transfer from CX1

We must choose a file to transfer. For the clarity of this tutorial, we suggest to copy the file $TOM_DIR/install.txt to
/tmp/file_to_send Any other file can be chosen for a transfer.

* Run the C:X operator interface (command $sterm).

C:X/UNIX 158-8
OPTION ===> D

IBM (R) Sterling Connect:Express (R)
Licensed Material - Property of IBM. (C) Copyright IBM Corp. 1999, 2011

DIRECTORIES _ MONITOR _ 3 TABLES _ 4 REQUEST
PARTNERS STATUS SSION _ 5 SSL
FILES LOG PRESENTATION

REQUEST DELETION

-F3- END

* Select option 4 REQUEST. Set the NAME to TEST, DIRECTION to T, PARTNER to cx2ssr, DPCSID ALIAS and
DPCPSW ALIAS to cxX1SSL (not necessary if they have been defined in the partner directory), DPCPSW ALIAS to CX1SSL,
PHYSICAL NAME to /tmp/file to_send.

C:X/UNIX 150-9

OPTION ===>

FILE ...

PARTNER -

DPCSID . . DPCPSW ALTAS ..........
DESTINATION
RECEIVER

NAME ......... : /tmp/file_to_send

-

- ( 2
. @ 2011@9@811@181 ( 'MMDDHHMMSS )
80 CHARACTERS FOR CARD)
e e B e R e e e s e e S R SR R O

-ENTER- NEXT FIELD -F3- CANCEL -F8- COMPLETION

¢ Press the F8 key. At the DO YOU WANT TO GO ON ? prompt press the ENTER key. The request number will be displayed at the
bottom of the screen.
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TRANSFER REQUEST

=1 DIRECTION ..
: CX25S|
H DPCPSW ALIAS .
DESTINATION
RECEIVER
/tmp/file_to_send

RECORD FORMAT .... co E TF, TV, BF, BU

RECORD LENGTH .. L
TYPE/STRUCTURE/MODE FTP : E/A/T/* F/R/*, B/S/*
STORE UNIQUE (FTP) . : Y/N FA :  Y/N  NOT :

: (N/L/H/M)

(X/P/T)
: (8/1/2)
.. : 20110908116432 (YYYYMMDDHHMMSS)

API FIELD (ETEBAC3 : 80 CHARACTERS FOR CARD
1...5....0....5....0....5....0....5....0....

PTED : 7] - TO LEAV
-ENTER- NEXT FIELD -F3- CANCEL -F8- COMPLETION

¢ Press the ENTER key then the F3 key to go back to the MAIN MENU.
¢ Select 2 MONITOR and 2 INTERROGATION OF LOG. We should be able to see the success of the file transfer.

INTERROGATION OF LOG - foxi
:16: 2811
COMMUNICATION OPENED (I) WITH: CX2SSL RE(): 06800006 PESIT
REQUEST 06800086 TEST TRANSFER ACCEPTED STRF 000OE32486
06800006 TEST TRANSFER STARTED STRF D0OOO32486
06800006 (R) /tmp/TEST_AGB00006.txt
068006006 TEST TRANSFER ENDED STRF 0000832486
REQUEST 06800006 RECEIVING =- CX2S5L FILE TEST NUME
COMMUNICATION CLOSED (I) WITH: CX2SSL REQ: 26800006 PESIT
REQUEST 06800087 TEST CX2SSL S 0000 TRC=0008L
REQUEST 06880087 <- bfn ACCEPTED (N)
REQUEST 06808887 ABORT -> CX2SSL
REQUEST 06800007 REJECTED <- CX255L
COMMUNICATION NOT OBTAINED -= X255L REQ: 86800087
REQUEST 06800087 RETRY WITH PARTNER CX255L

EPTED
RTED
o_send

ER ENDED

-F3- END -F7- PREVIOUS SCREEN -F&- NEXT SCREEN =F11- ->

We can see from the log above that the request 06800007 was a transfer of the file TEST (TEST TRANSFER ACCEPTED), it has
been successful started (TEST TRANSFER STARTED), it was a transmission ((T)) of the file /tmp/file_to_send and it has
ended successfully (TEST TRANSFER ENDED).

Another way to check that the file has been successfully transferred to the CX2 instance is to use the CX Graphical Interface on the cx2
host.

* Expand the CX2 node in the left pane and double-click on Management. Sign in using ADMIN for both the Client and the

Password.
= Connect:Express - Graphical Interface

File Edit  View ‘Window  ?
| 2l 1% 2,

=14& ConrectExpress
E% Cx2 C:X Windows

Bl Management
o Configuration

Cliert :

Password

Cancel |

52/66



PeSIT file transfer with IBM Sterling Secure Proxy

¢ In the middle pane select Directories > Messages

then double-click on Selection in the right pane.

s Connect:Express - Graphical Interface - [Management - Monitor: CX2 - Client: ADMIN]

File Edit Wiew Management Window 7 o
3] % 2|
Transfer Monitor - Connect:Ex | Name
=4 ConnectExpress = Directories Eilzelection
= =2 © Partners
M anagement 9 Files
Corfiguration sl 9 Clients
0 55 Clients
—|= ﬁ Monikor
i ‘ Requests
g Actlwty
@ ‘ Journal
& Notifications
_4 E % Parameters
=] = 48 Monitor
=
= % Networks
= % 550 Servers
L =48 Tables
0F =48 PesIT
= % Session
-4 % Presentation
Fa = % Erebac-3
E % Presentation
S
P
il
< EANES >

* Optionally use the Begin time and End time text fields to set the time slot. You can refer to the CX1 log for the time of the transfer
(in this example the transfer has been done around 11:06:00). Click the OK button in the Selection in LOG window.

C:X - Selection in LOG |

Begin

Begin dat Beain fi

PAAMM/DD] 2011 708/08 A5 110500

End

End dat End fi

CCMM DD] 2011 /0308 [HHMMSs). 110700
Drefault | ak | Cancel |

* We can see from the following log that the request 201125100003 was a reception of the file TEST (TEST TRANSFER STARTED

(RECEIVE)) and it has ended successfully (TEST

- TRANSFER ENDED).

Date | Time

‘ Comment

[El=n11/09/08
[Bilz011j09y02
[Elen11/09/08
[El=n11/09/08
[El=011/09/08
[:l2011/09/08
[El=011/09/00
[El=011/09/08
[Eil=011/09/08
El=011/09/00
SEIE(tinn

11:05:25
110525
110525
11:05:25
11:05:25
110525
110525
11:05:25
110525
110525

201125100003 - INCOMING CALL (S5L/TCF) ACCERPTED

201125100003 - COMMUNICATION OPEMED {IM) WITH Cx155L (SSL/TCF)
201125100003 - TRANSFER ACCEPTED

201125100003 - TEST - TRAMSFER STARTED (RECEIVE)

201125100003 - TEST - TRAMSFER ENDED

201125100003 - DISAELED

201125100003 - PURGED

201125100003 - COMMUNICATION CLOSED WITH CX155L (SSLITCR)
201125100004 - DISABLED

201125100004 - PURGED

Note that the request number (201125100003) is not the same as the request number in CX1 (06800007). This is normal because
the 2 C:X instances maintain different request counters.
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File transfer from CX2

As for the file transfer from CX1 partner we need to choose a file to transfer. For the clarity of this tutorial, we suggest to copy the file
C:\cexpress\tomnt.ini to C:\tmp\file to_send.txt. Any other file can be chosen for a transfer. Start the CX Graphical

Interface to do the transfer.

Expand the CX2 node in the left pane and double-click on Management. Sign in using ADMIN for both the Client and the

Password.

= Connect:Express - Graphical Interface

Filz  Edit View ‘Window 7

] sl 1) 2

= fg} CannectExpress
[ER="Yel]
Management

-4 Configuration

Ll File Edit Wiew Management Window 7

[

X Windows

Client :

Pazzward

‘o =l =X 2

Egi’ Connect:Express
[ =

Management
Configuration

3
=

=%

c

-

=8

[~

Clients
550 Clients

Messages
Journal
Motifications

E--% Parameters

Manitor

Bty Metworks

% 95L Servers
Tables

88 pesIT

% Session

% Presentation

Bt Crebac-3

: % Presentation

Mame

E Mew simple Request

E New exkended Reguest
& Mew ETEBAC-3 Request

=

For Help, press F1
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* In the Client window, leave ADMIN selected in the client drop down list and click the Next > button.

New transfer request - Client

ﬂ This wizard will help you create a new Simple Hequest:

Choose the name of the client for which you want to
submit the transfer request:

client :

| Mest > |

Cancel |

Help

¢ In the File dialog window, select TEST in the File name drop down list, set the Physical name to C: \tmp\file to_send.txt,
leave the value for the Label, check that Transmission radio button is selected in the Direction box, select CX1SSL in the

Receiver partner list.

Click the Next > button.

New transfer request - File

File name: TEST - Enabled
Physical name: [C:mpAfie_to_send ta
Label |E:\tmp\fileﬁloﬁsend bt
Pig3/P191
Offset : Walue :
Direction
@ Transmizzion " Reception
Receiver parther: Sender parther:
CH185L -
Application |D: |
Priarity
& Nomal " Low " High
Type
* MNarmal o " Hold " Message
< Back Mest » Cancel Help

X

¢ In the Schedule dialog window click the Next > button.
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New transfer request - Schedule

X

Startup date [v™' /MM DD]
Startup time [HH:MM:55]

< Back | Mext » | Cancel Help

¢ In the Notification dialog window click the Finish button.

New transfer, request - Notification

X

[ Maotification Client name:

< Back | Finish | Cancel Help

A message window will be displayed giving the request number.
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-
1 ) 001 requesk(s) accepted - Mumber: 201125100007

¢ Click the OK button.

* To check the result of the transfer, select Directories > Messages in the middle pane then double-click on Selection in the right
pane.

mConnect:Express - Graphical Interface - [Management - Monitor: CX2 - Client: ADMIN]
File Edit View Management ‘Window 7 -

B

Transfer Monitar - Connect:Ex | pame
=I-§& ConnectEspress -0 Directories [Elselection
5 ) 8 Partners
Management 0 Files
Configuration 0 Clients
o 551 Clients
= @ Monitar
& Requests
Ackivity
al =
= f essages
5] & Tournal
& Notifications
= % Parameters
=
(=] - Moritor
=5 By Networks
EJS % 5L Servers
als =48 Tables
o5 = Hg pesiT
2 % Session
= % Presentation
& -8y Erebac-3
Presentation
= L
K
"
Tl
S5 | &) | >

¢ Optionally use the Begin time and End time text fields to set the time slot. You can refer to the CX1 log for the time of the transfer
(in this example the transfer has been done around 17:58:00). Click the OK button in the Selection in LOG window.

C:X - Selection in LOG

Begin
Eeqin date Begin time
MQKWJMWDD] 2011/09/08 [HI-QIMM:SS] 17:57:00
End

End dak End i
oMM /DD] |20 /808 FHMMss)  [1E1ES0

Drefault | ok Cancel |

¢ We can see from the following log that the request 201125100007 was a transmission of the file TEST (TEST TRANSFER
STARTED (TRANSMIT)) and it has ended successfully (TEST - TRANSFER ENDED).

57/66



PeSIT file transfer with IBM Sterling Secure Proxy

Date | Time Comment

ZDIIIDQJDE 17:58:10  C20112510006 - 201125100007 - ACCEPTED (M)

17:58:10 201125100007 - SELECTED

201 1/09j08  17:58:10 201125100007 - COMMUNICATION OPENED {OUT) WITH CR155L {SSLITCR)
2011/09/08 1715810 201125100007 - TRANSFER ACCEPTED

17158110 201125100007 - TEST - TRANSFER STARTED (TRANSMIT)

17:56:10 201125100007 - TEST - TRAMSFER EMDED

17:58:10 201125100007 - DISABLED

17:58:11 201125100007 - COMMUNICATION CLOSED WITH Cx155L (SSLJTCF)
1758111 201125100007 - PURGED

Another way to check the result of the transfer is to use the C:X operator interface on host cx1.

* From the MAIN MENU select 2 MONITOR and 2 INTERROGATION OF LOG. We should be able to see the success of the file
transfer.

-- INTERROGATION OF LOG --

Thu Sep 8 18:34:35 2011
REQUEST @68880R7 (T) /tmp/Tile to send
REQUEST 06880087 TEST TRANSFER ENDED STRF 0000005508
REQUEST 068880087 TRANSMITTING -> CX2SS5L FILE TEST NUMB}
COMMUNICATION CLOSED (0) WITH: CX2SSL REQ: 868000087 PESIT
REQUEST 06800008 TEST CX255L SRC=0000 TRC=0OBOL
REQUEST 06880008 <- bfn ACCEPTED (N)
COMMUNICATION OPENED (0) WITH: CX255L REQ: 06800808 PESIT
REQUEST 068088688 TEST TRANSFER ACCEPTED STRF 0060887615
REQUEST 068008888 TEST TRANSFER STARTED STRF 0000EOTE15
REQUEST @©6820008 (T) /tmp/Tile to_send

REQUEST 06800008 TEST TRANSFER ENDED STRF 00EOEOTE1S
REQUEST 06800008 TRANSMITTING -> CX2SSL FILE TEST NUMB}
COMMUNICATION CLOSED (0) WITH: CX255L REQ: 86880008 PESIT
C C REQ: € g

EPTED

-F2- END -F7- PREVIOUS SCREEN -FB- NEXT SCREEN

We can see from the log above that the request 06800009 was a transfer of the file TEST (TEST TRANSFER ACCEPTED), it has
been successfully started (TEST TRANSFER STARTED), it was a reception ((R)) and the received file has been save under the
name /tmp/TEST A6800009.txt ( the file name in the definition of the file TEST is /tmp/TEST &REQNUMB.txt) and the
request has ended successfully (TEST TRANSFER ENDED).

Troubleshooting

Connect:Express and Sterling Secure Proxy can provide trace which help to diagnose problems. Enabling trace usually decreases
performance and must be left inactive during normal production operation.

Enable trace in C:X for UNIX

Trace can be enabled by setting STRACE=1 in the $TOM_DIR/config/sysin configuration file. This requires however to restart the
monitor. There is a dynamic way to change the trace activity. The command:

|$TOM_DIR/config/ch_conf /STRACE=1

will activate the trace, while the command:

[$TOM _DIR/config/ch_conf /STRACE=0

will stop the trace activity.

Trace will be written in different files in the $TOM_DIR/strf directory (refer to the IBM® Sterling Connect:Express® for UNIX - User
and Installation Guide for the details). The more relevant trace files to diagnose SSL problems are the trace files RTQQONNNNN. pid
for outbound transfers and RTQQQNNNNN . pid for inbound transfers.

Enable trace in C:X for Microsoft Windows

There are 2 levels of trace in C:X for Microsoft Windows. Both can be activated using the CX Graphical Interface.
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Enable PeSIT protocol trace
A first level of trace to help diagnose PeSIT protocol problems when C:X is used as a server or a client can be enabled.

* In the left pane expand the CX2 node and double-click on Configuration. Sign in using ADMIN for both the Client and the
Password.

P
a2l =X 2

=I4& ConnectExpress

=Bl X2
@] Management
Configuration

Clignt :

Password:

= 1= N AR EA -

L T

¢ In the right pane double-click on Files.

;ﬁConnecl:Express - Graphical Interface - [Configuration - Monitor: CX2 - Client: ADMIN]
93 File Edit View Configure ‘Window 7

a| =% x| 2
MName
=z ConnectExpress “Enstartup
= [oiv] Baservice
B tanagement W
8% Configuration “Hanotification
[ Networks

% 55L Servers

¢ Tick the Enabled check box in the Trace box and click the OK button.

F

Parameters of Monitor: CX2 E|
Fies |
Joumal
¥ Fesst Size: 1000 :I
Log
¥ Feset Size 1000 :I
Naotification
¥ Reset Size: 1000 :I
Trace
I¥ Enabled
Statistics
I Enabled r
Mumber of days kept during daily purge :
Time of daily purge [HH:kM):

ak Cancel Help

¢ Click the OK button.
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There is no need to restart the monitor. The trace will be written in the file CYYYYDDDNNNNN. txt where YYYY is the year, DDD is the
day of the year (001 to 366) and NNNNN is the request number. Be aware that restarting the CX monitor during the same day will reset
the request counter to 1 and therefore trace files could be overwritten without notice. Below is an example of the trace file

C201125400002.txt.

17:459:57 — AMMINMIT - TYPE= Ol LINk= 02
17:49:57 - PLCLIOSA (entry) - STATE=0101
17:49:57 - AMMSENDDATA LG= 124

17:49:57 - sent LG= 124
17:49:37 - ANMRECEIVEDATA LINK= 2

17:49:57 - ANMRECEIVEDATA DEMANDE= 18000 DEJA=0

17:45:57 — AMMSEMDDATA LG= 10
33 31 20 50 41 53 53:0d Qa

17:49:57 - sent LG= 10
17:49:37 - ANMRECEIVEDATA LINK= 2

53 45 52 20 41 44 4d:49 4e 20 20 20 od

17:49:57 - ANMRECEIVEDATA DEMANDE= 16000 DEJA=0

0000 50 41 53 53 20 33 38 33:39 33 41 44 30 43

0010 31 43 32 43 30 0d 0Oa

17:49:57 — AMMSENDDATA LG= §
0000 32 33 30 20 0d 0a

17:49:57 - sent LG= &
17:49:37 - ANMRECEIVEDATA LINK= 2

17:49:57 - ANMRECEIVEDATA DEMANDE= 18000 DEJA=0

0000 53 49 54 45 20 31 31 39:32 2e 31 36 38 Ze

0010 36 32 20 20 20 33 31 30:31 0d 0a

17:49:57 - PLCLIOSA (entry) — STATE=0107
17:49:57 - AMMSEMDDATA LG= 38

33 30 20 31 31 31 30:30 30 30 30 30 31

0010 31 31 31 51 51 31 31 31:31 31 31 31 31 31

0020 31 31 31 31 31 0od 0a

17:49:57 - sent LG= 39

17:49:57 - PLCLIX28 (entry) - STATE=0200
17:49:57 - AMMRECEIVEDATA LINK= 2

17:49:57 - AMMRECEIVEDATA DEMANDE= 16000 DEJA=0
RECW= 30

Enable SSL handshake trace for server

The second level of trace which can be activated is the SSL handshake trace. It can be very useful to diagnose problem during a SSL
connection between a CX monitor trying to connect to SSP.

e
o

w

a

31
31

31
31

220-C:E for wind
ows NT 31001 199
8/05 00000000, .2
20-(C) Copyright

IEM Corp 19G66-2
010..220 C200125
4000220110011
- 17:45:57..

USER ADMIMN

331 PASS..

PASS 3B303ADOCSD
1c2C0. .|

SITE 1152.168.0.
62 3101..

230 1110000000111
1111111111111311
11111..

¢ In the right pane of the Configuration-Monitor window, double-click on SSL Servers.

* Double-click on CX2SSL.

s

i

m Connect: Express - Graphical Interface - [Configuration - Monitor: CX2 - Client: ADMIN]
93 File Edt View Configure Window 7

3] el #1x) ¥

gjﬁ File Edit Wiew Configure Window ?

BECESK

Mame
=-b CornectExpress Startup
= Cr2 4 service
% Management BaFiles
Canfiguration ahiatification

i Connect: Express - Graphical Interface - [Configuration - Monitor: €X2 - Client: ADMIN]

Mame

=1-§& ConnectExpress
= Cx2

Management
Configuration

¢ Select the Trace radio button Medium or Full.

# Mew S50 Server
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SSL server properties:CX255L El

General I Cipher suites }

I'J'*j1 2561

L

Status: ¥ Enabled [~ Client authentication 55U serverport,  |9100
Protocol : TS V1.0 & S5LY30 " 55Lv20

Trace: " Mane ' Medium O Ful

™ Data are prefised with 2 bytes length

Certificate store

Stare provider: \STDHE_PHUV_SYSTEM j
Store location: |55 TEM_STORE_LOCAL_MACHINE |
Store name: ‘My

Certificate name
Subject DN
|Cx2 Centificate

lssuer DN:

(1] | Cancel Help

¢ Restart the CX monitor.

The trace of the SSL handshake when the monitor is used as a server will be written in the file YYYYDDDNNNNN. txt where YYYY is the
year, DDD is the day of the year (001 to 366) and NNNNN is the request number. Be aware that restarting the CX monitor during the

same day will reset the request counter to 1 and therefore trace wiles could be overwritten without notice. Below is an snapshot of the
trace file 201125100002. txt.

152:54 - AMMINIT - TYPE= Q0 LIMK= 04
17:52:54 - PlcaL05a - 010l
- CALLOUT - ADDR= HNAME= s5p PORT=16200
17:52:54 — connect RC= -1
17:52:54 — connect RC= O - Adresse: N° Port: 16200
5SL:HeapHandle = 150000
SSL:0pening Store. Provider = CERT_STORE_PROWV_SYSTEM
SsL:iopening store. Location = CERT_SYSTEM_STORE_LOCAL MACHINE
SSL:0pening Store. wName = b
Certificate to find: cx2 certificate
Certificates in: STORE_PROV_SYSTEM : SYSTEM_STORE_LOCAL_MACHINE : My

Certificate subject: C=FR, L=Paris, O=IEM, oOU=France Labs, CN=Cx2 Certificate

CERTIFICATE FOUND (CERT_<500_WAME_STR | CERT_MAME_STR_NO_PLUS_FLAG): C=FR, L=Paris, 0O=IEM, OU=France Labs, CN=Cx2 Certific:

Certificate to find: Cx2 Certificate
Certificates in: STORE_PROV_SYSTEM : SYSTEM_STORE_LOCAL_MACHINE : ROOT

certificate subject: pC=com, pC=microsoft, cn=microsoft rRoot certificate authority

certificate subject: ou=Copyright (c) 1997 Microsoft Corp., ou=Microsoft Corporation, Ch=Microsoft Root Authority
certificate subject: C=FR, L=Paris, O=IBM, oU=France Labs, cn=SsP certificate

certificate subject: c=us, o=MSFT, CN=microsoft authenticode(tm) rRoot Authority

certificate subject: o=microsoft Trust wetwork, ousmicrosoft Corporation, ousmicrosoft Time Stamping Serwvice Root, oU=Copyr
Certificate subject: O=verisign Trust Network, oU="verisign, Inc.”, oU=verisSign Time Stamping Service Root, OU="MO LIAEILI
certificate subject: C=hk, o=Cé&w HKT Securenst CA SGC RODT

certificate subject: C=FR, o=Certplus, CM=Class 3TS Primary Cai

Certificate subject: C=Mx, CN="aAutoridad Certificadora del Colegio Nacional de Correduria Publica Mexicana, A.C.", 0="Coleg

certificate subject: C=us, s=utah, L=sSalt Lake City, o=pigital sSignature Trust co., ou=united Parcel service, CwN=DST (UPS)

certificate subject: C=FR, o=Certiposte, Ch=Certiposte Classe A Personne

Enable SSL handshake trace for client

To help diagnose SSL problems when SSP tries to connect to a CX monitor, the trace can be enabled at the client level.

¢ Expand the CX2 node in the left pane and double-click on Management. Sign in using ADMIN for both the Client and the

Password.
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¢ In the middle pane select Directories > SSL Clients then double-click on CX2CLI in the right pane.

Double-click on CX2SSL.

s Connect:Express - Graphical Interface

File Edit Wiew Window ?
TS

= ﬁti' Connect Express
[ER="g]

Management
By Comfiguration

C:X Windows

Cligt :

Passmord:

MConnect:Express - Graphical Interface - [Management - Monitor: CX2 - Client: ADMIN]

Lk File Edit view Management Window ?

5| 2%l Z(x| 2

[SE 53 ConnectExpress
=5 Rz

Management
i Corfiguration

B o _Transfar Manitar - Connect:Ex | Mame
_I =) Directories £ Mew 55L Client

4 Partners [ Jerahl

Qg Fle Edit view Configure Window 7

o s @lx) )

| Name I

=% Connect Express 5 Mew 55L Server

[ER=g ]

M anagement
Configuration

Select the Trace radio button Medium or Full.
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SSL server properties:CX255L

X

General I Cipher suites }

I'J'*j1 2561

L

Status: ¥ Enabled [~ Client authentication 55U serverport,  |9100
Protocol : TS V1.0 & S5LY30 " 55Lv20

Trace: " Mane ' Medium O Ful

™ Data are prefised with 2 bytes length

Certificate store

Stare provider: \STDHE_PHUV_SYSTEM j
Store location: |55 TEM_STORE_LOCAL_MACHINE |
Store name: ‘My

Certificate name
Subject DN
|Cx2 Centificate

lssuer DN:

(1] | Cancel Help

¢ Click the OK button. There is no need to restart the monitor.

The trace of the SSL handshake when the monitor is used as a client will also be written in the file YYYYDDDNNNNN. txt.

Enable trace in SSP

Sterling Secure Proxy has trace facilities which help to diagnose problems. There are many components in SSP for which the trace can
be independently enabled (engines, perimeter server, adapters, etc).

Enabling SSL or TLS trace

Enabling SSL or TLS trace can be very useful to diagnose handshake problems. Enabling trace is done through the SSPcm graphical
interface.

* Connect to the SSPcm graphical interface with administrator privileges (the section Import the self-signed certificates in SSP
explains how to connect to the SSPcm graphical interface).

¢ On the left pane expand Engines and click sspEngine.
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IBM: Sterling Secure Proxy

* select the Advanced tab and select DEBUG from the Certicom Logging Level drop down list.

Canfiguration Manitaring Credentials Advanced System Help Sign Out
Configuration Actions 7 Basic Advanced SSP Engine Configuration
< [ Engines
b [ sspEngine * Engine Name: [sspEngine

b 5 cx1PeSITAdapter Description: SSP Engine

b g cx2PeSiTAdapter
b g Adapters * Engine Host [ssp |
b £2 Netmaps * Engine Listen Port
b fig Policies

save | | Cancel | [ Help

IBMs Sterling Secure Proxy

{ C Manitoring Credentials Advanced System

Configuration Actions ¥ Basic Advanced

| < B Engines

[ 13 [ sspEngine Engine Logging Level
I ey cx1PeSITAdapter Local Perimeter Server Logging Level:
e
| b pzy cx2PeSITAdapter Certicom Logging Level:
s
| b g Adapters User Store:
| b £2 Netmay
| I £% Netmaps
I @z Policies

¢ Click the OK button to save the new configuration.

SSP Engine Configuration
[ERROR =l
[ERROR = |
[DpEBUG =
| defUserStore =l
save | [ cancel | [ Help

¢ Every time you save the configuration, a version number is incremented. By default, SSP is checking if there is a new configuration
in SSPcm every 30 seconds. You can check if the configuration version numbers are the same by selecting the Monitoring in the

top banner and select Engine Status in the left pane.
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¢ Once the trace is enabled you can try a file transfer from the CX1 partner to the CX2 partner. On the SSP host , navigate to the
directory where SSP has been installed. Go into the 1ogs directory. You should see a file named certicom. log. This file

IBM: Sterling Secure Proxy

Configuration Monitoring

Credentials

Advanced System

Monitoring
>[5 Engine Status (All)
b [ sspEngine

Engine Status (All)

Refresh Interval (secs) (30 | | Save | | Help |
Engine Name Last Pushed Message CM Ver Eng. Ver
sspEngine 2011.08.16 16:49:43 Version 3.4.00 18 18
Lastpoll:  08/16/11 05:11:34 PM Stop Engine | [ Push Config
Message:

contains the trace of the SSL handshake.

5

[TET RV E v

P ERRREERERRE Y Y Y Y Y Y Y Y VY Y VR RERR PR R Y Y VY YRR R R R R
& AOOGDENO S EyEg ey 56O DD G

PR AV AVEVEAVEVEVEVEVEVEVEVEY]

Some part of the file above have been truncated to make it more readable.

sept. 2011 17:36:32,359 INFO
Cipher suites
TLS_RSA_WITH_AES_256_CEC_SHA
TLS_RSA_WITH_3DES_EDE_CBC_SHA
TLS_RSA_WITH_AES_ 128 CEC_SHA
challenge

F8 82 B4 24 1A 80 15 4E 62 07
3B 7A_BC F1 D7 F3 5C 1C 40 16
Protocolversion

TLS1
sept. 2011 17:36:32,359 DEBUG ... sys
sept. 2011 17:36:32,358 DEBUG ... S¥5
sept. 2011 17:36:32,359 DEBUG ... S¥S
sept. 2011 17:536:32,339 DEBUG ... sys
sept. 2011 17:36:32,359 DEBUG ... 5y5
sept. 2011 17:36:32,359 DEBUG ... sys
sept. 2011 17:36:32,358 DEBUG ... S¥5
sept. 2011 17:36:32,359 DEBUG ... S)/S

sept. 2011 17:36:32,358 DEBUG

p pr ] s
[1] 1316187110468 bedS?ScecSGGaOZFZEbSSEOEebGCBGGd [1316184620562]

Sys.

CERTICOM - protocol=pesit

BO 42 73
B6E 95 BB

LCERTICOM
.CERTICOM
LCERTICOM
LCERTICOM
LCERTICOM
LCERTICOM
.CERTICOM
LCERTICOM

SCERTICOM

4
2

0 98 77
B AZ D4

protocol=pesit

protoco 316187392203_6 ...
protoco 316187392203 6 ...
protoco 316187392203 6
protoco 316187302203 _
protoco 316187392203 _¢
protoco 316187592203_¢

protoco 316187392203

otocol=pesit

[1316187110468] 1316184620562 7a&6fc0ddaddce2f842082d0fehc2alf [1316184440187]
[1316184620562] 1316184440187 f34017CCaz36C84953543582179288527 [1316184080578]
[1316184440187] 1316184080578 33a7459d7F6.143520009cd0892060d779 [-1]

sept. 2011 17:36:32,358 DEBUG ... Sys.
sept. 2011 17:36:32,359 DEBUG ... sys.
sept. 2011 17:536:32,339 DEBUG ... sys
sept. 2011 17:36:32,359 DEBUG ... Sys.
sept. 2011 17:36:32,359 DEBUG ... sys.
sept. 2011 17:36:32,358 INFO SyS.
sept. 2011 17:36:32,359 INFO SYS.
SessionID
3E 77 90 20 30 95 31 6E 0E C7

wNegotiated cipher suite
TLS_RSA_WITH_AES_256_CBC_SHA
Random message

4E 73 6D 00 80 67 D8 D3 37 Ad
4B 21 73 5C 6D 06 35 09 B4 36
Protocolversion
recordversion
S5L3
sept. 2011 17:36:32,359 DEBUG ... sys
sept. 2011 17:36:32,358 DEBUG ... S¥5
sept. 2011 17:36:32,359 DEBUG ... S¥S
sept. 2011 17:36:32,359 DEBUG ... sys
sept. 2011 17:36:32,359 DEBUG ... 5y5
sept. 2011 17:36:32,359 DEBUG ... sys
sept. 2011 17:536:32,339 DEBUG ... sys
sept. 2011 17:36:32,359 INFO ... sys
%. 2011 17:36:32,375 DEBUG ... sys.
Sep 2011 17:36:32,375 DEBUG

ava.
;ept. 2011 17:36:32,375 INFO . Sys.CERTICOM
certificate[o]
certificate:
serial number: 122840508516%7992781
version:
Type: x.509
subject
C=FR, L=Paris, 0=IBM, OU=France Lahs,
Issuer
= O=IEM,

C=FR, L=Paris,
validity:

Mot Eefore:wed Sep 07

wot after :Thu sep 06
subject public_key Info:

Public Key Algorithm :RSA

RSA PUbTiC Key:

CERTICOM
CERTICOM

LCERTICOM

CERTICOM
CERTICOM
CERTICOM
CERTICOM

BE 30 8B

20 34 6a
32 10 F1

LCERTICOM
.CERTICOM
.CERTICOM
LCERTICOM
LCERTICOM
LCERTICOM
LCERTICOM
.CERTICOM

CERTICOM

. 5. CERTICOM
Tlang.reflect. InvucatwnTargetExcepN an

1

D
5

protocol=pesit 316187392203 6 ...
protoco esit 3168187392203 6 ...
protoco esit 316187392203 6
protoco esit 316187392203_6
protoco esit 316187392203 _6
protoco esit 316187392203_6
protocol=pesit 1316187392203_6

0 7D 7a

E DO 26

9 0E AR

protocol=pesit 1316187392203_6
protoco i 316187392203_
protoco 316187392203 _¢
protoco 316187392203 _¢
protoco 316187302203 _
protoco 316187392203 ¢
protoco 316187392203 6 ...
protoco 316187392203_6 ...
protocol=pesit 1316187392203_6 ...

protocol=pesit

protocol=pesit

Cn=ssP Certificate

olU=France Labs, Cn=33P Certificate

16:17:57 CEST 2011
16:17:57 CEST 2012

sessid=1316187392203_6 ...

1316187392203 6 ...

1316187392203 6 ...

sessid=1316187392203_6 ...
sessid=1316187392203_6 ...

[com.

caom.

[com.certicom.t]s.interfaceimpl.i{3}]chooseserveralias(rRSA,null, nulld

cam.
cam.
caom.
conm.

cam.

com.
caom.
cam.
com.
cam.
cam.
cam.

certicom.

certicom.
certicom.
certicom.
certicom.

carticom.

certicom.

certicom.
certicom.
certicom.
certicom.
certicom.
certicom.
certicom.

ava.lang.Class{3}]iscertificatevali
Java.lang.Class{3}]valid
com. certicom. t1s. interfaceimpl. 1{3}]chooseserveralias done

tls.
tls.

.record. handshake. R{2}]

.record. handshake. r{1}]

S5L2.0 RECORD CLIENT HELLO

pefaultTLssessionDBd3}]session DE CleanupDB

pefaultTLSSessionDEL3 H]Before:

.pefaultTLssessionpe = }]Before:

.record.afl}]ce—-Local 22
SERVER HELLO

null

[com. certicom. t1s. interfaceimpl. 1{2}]getcertiﬁ'catechain(RSAOj

[java.lang.Class{3}]iscertificatevali

[Java.lang. C1ass{3}]va id

[caom.
[caom.
[cam.
[cam.
[com.

[com.

[caom.

certicom.t]
certicom.
certicom.
certicom.
certicom.

certicom.

certicom.

s.interfaceimpl.i{3}]chooseserveralias done
Lintarfaceimpl. i{3}]getCertificatechain(rza0)
cinterfaceimpl. i{3}]getPrivaterey(RSA0)
.record.afl}
.provider.Providermanager{3}]

C¢=-Local

.provider.providermanager {3}]

.record. handshake. R{1}]

CERTIFICATE

? RsA RSA nUTT null null

Linterfaceimpl. TLsConnect onImpl {3 }]number of complete handsh
.record. handshake. x{3}]accepting client
intarfaceimpl. 1{3}]chooseserveralias(rRsa,null, nullld
.interfaceimpl. 1{3}]EetcertwﬁcateCham(RSA )]

7 Rsa RSA nUTT nulT Aull

{f94017cca206c849535430a17592¢8
.Defau1tTLSSEss‘|DnDB{E}]maxDBSuE 4096

.DefaultTLsSessionDE{3 1111 1Mi1115=3600000
.DefaultTLssessionpg{3 }]session DB no change
.record. handshake. x{3}]Retreived session:
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PeSIT trace in SSP

Below is a list of other components for which a trace can be enabled in SSP.

* PeSIT adapters: trace for PeSIT adapters is written in files of the form secureproxy-pesitNetmap.<node name>.log in the
logs directory. Trace gives interesting informations about the status of inbound and outbound sessions.

* PeSIT Netmap nodes: PeSIT trace for inbound nodes (there is no trace for outbound nodes). Trace files are written in the log
directory in the form pesit.<node_name>.<session_id>.trace. The trace gives the detail of the messages exchanged
between the PeSIT node and SSP.

References

¢ IBM® Sterling Connect:Express® for UNIX - User and Installation Guide: CXUX15_UserGuide.pdf (comes with the product).

¢ IBM® Sterling Connect:Express® for Microsoft Windows - User Guide: CXWIN31_UserGuide EN.pdf (comes with the product).

¢ IBM Sterling Secure Proxy 3.4 Help: http://help.sterlingcommerce.com/SSP34/index.jsp (requires to create an account)

* OpenSSL for Windows: http:/gnuwin32.sourceforge.net/packages/openssl.htm
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